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EXECUTIVE SUMMARY 

Deep site characterization at high resolution is essential for the efficient design and 

construction of transportation infrastructure, as unanticipated subsurface conditions can cause 

significant challenges during and after construction. Current FDOT practices rely on standard 

penetration test (SPT) data, which investigate less than 0.1% of soil and rock under a structure, 

leaving the spatial variability of subsurface materials—common in Florida’s karst limestone—

largely unresolved. This variability, including cavities, weak zones, and dipping layers, can 

necessitate changes in foundation type or size, particularly for large-diameter, non-redundant 

drilled shafts. 

Non-invasive geophysical methods offer extensive subsurface coverage at a lower cost 

compared to invasive tests. However, surface-based seismic techniques, such as 2D and 3D full-

waveform inversion (FWI), face limitations in resolution and depth. Specifically, surface-based 

FWI experiences a decline in resolution and accuracy with increasing depth, as the data are 

predominantly influenced by Rayleigh wave components that travel horizontally near the surface, 

with only limited contributions from body wave components at greater depths. To overcome these 

challenges, a novel SPT-seismic FWI technique has been introduced. This approach captures body 

wave energy at depth, enabling high-resolution 3D imaging down to 150 feet, all without the need 

for dedicated geophysical boreholes. 

The primary objective of this project was to develop a robust 3D SPT-seismic full-

waveform inversion (FWI) algorithm and an accompanying graphical user interface (GUI) module 

for advanced geotechnical site characterization. The developed algorithm enables high-resolution 

3D imaging of subsurface structures to any standard penetration test (SPT) depth, extending to 150 
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feet. The GUI module is designed for user-friendly applications and has been transferred to the 

Florida Department of Transportation (FDOT) for future site investigations.  

The developed SPT-seismic method offers several significant advantages. First, in-depth 

seismic waveform data are acquired directly from SPT testing, eliminating the need for additional 

geophysical boreholes. Second, unlike surface-based seismic data dominated by surface waves, 

the in-depth SPT source generates rich body wave data, enabling higher resolution imaging at 

greater depths through multiple waveforms converging on the same spatial point. Third, this 

method requires a smaller test area on the ground surface compared to traditional seismic 

techniques, making it particularly suitable for constrained environments such as urban areas, right-

of-way, or even underwater settings (e.g., using hydrophones). Additionally, standard SPT 

borehole testing (e.g., N-values, tube sampling, and coring) can be conducted simultaneously for 

verification and correlation with seismic results, ensuring comprehensive soil and rock property 

assessments for design purposes. 

The method has been validated through field experiments at three test sites in Florida: 

Newberry, Bell, and Kanapaha. At each site, data acquisition involved deploying 72 vertical 

geophones with a resonance frequency of 4.5 Hz across a 6 × 12 grid with 10-ft spacing. Seismic 

energy was generated by a 140-lb SPT hammer dropped from a height of 30 inches onto the top 

of the SPT rod above the ground surface. The impact transferred energy to the SPT spoon at the 

rod’s end, functioning as an in-depth seismic source. A seismic trigger mounted on the SPT rod 

synchronized data recording for each hammer strike. Field results demonstrate the 3D SPT-seismic 

FWI method effectively resolves subsurface S-wave velocity (Vs) structures with high resolution 

and detects voids and anomalies of various sizes and depths.  The subsurface profiles are 

characterized in 2 ft-pixels over a large 3D domain up to 60 ft away from the borehole to any 
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depths reached during SPT. The inverted Vs profiles closely align with results from SPT, 

confirming their accuracy in identifying voids and limestone layer depths. 

The SPT-seismic method’s ability of characterizing soil and rock in a 3D domain around a 

SPT borehole is significantly important for efficient design of deep foundations. It allows using a 

single SPT at the center of a pile group to characterize the entire volume of materials supporting 

all piles in the group. The method can help reduce the cost of invasive tests, as well as minimize 

the risk of pile failure or collapse due to unexpected site conditions. A standalone GUI software 

module for the 3D SPT-seismic FWI method has been developed and transferred to FDOT for 

future uses in geotechnical site characterization. Applications include sinkhole investigations, 

assessing variable site conditions, delineating problematic soils, and correlating geophysical 

results with engineering parameters (SPT-N value) for foundation design. 
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Chapter 1 – INTRODUCTION 

 

1.1 Background 

Geotechnical site investigations are critical for the design and construction of foundations, 

which support heavy loads from superstructures like bridges, buildings, and roadways. Depending 

on the magnitude of the loads and the subsurface conditions, foundations may range from shallow 

systems near the surface to deep foundations extending over 150 feet, such as drilled shafts or pile 

groups. These deep foundations rely on the surrounding and underlying soil or rock for load 

bearing through skin friction and tip resistance. However, uncertainties in subsurface conditions, 

such as the presence of voids, weak zones, or variable material properties, pose significant 

challenges to foundation design and construction (Salgado, 2022). A void near or beneath a pile 

group, for instance, can lead to foundation failure or even collapse. 

Subsurface conditions are typically evaluated using invasive methods like the standard 

penetration test (SPT), cone penetration test (CPT) or rock coring (Mahmoud, 2013; Robertson, 

2016; Wazoh, 2014). While these tests provide reliable data within the borehole, they cannot detect 

voids or anomalies located outside the borehole. As a result, multiple invasive tests are often 

required for the design of large pile groups, especially at sites with high spatial variability. 

However, the time and costs associated with these tests can become prohibitive. 

Surface-based geophysical methods, such as seismic tomography (Nolet, 1987; Rawlinson 

et al., 2010), electrical resistivity (ER) (Banton et al., 1997; Farooq et al., 2012), and ground-

penetrating radar (GPR) (Jol, 2009; Wai-Lok Lai et al., 2018), are often employed to supplement 

invasive techniques by providing a broader view of subsurface conditions. Among these, seismic 
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methods are particularly valued for their ability to derive engineering properties (e.g., S-wave and 

P-wave velocities, Young’s modulus, and shear modulus) and achieve higher resolution with 

depth. Full-waveform inversion (FWI) techniques (Mirzanejad & Tran, 2019; Tran et al., 2013; 

Tran & Sperry, 2018)  have proven effective for producing 2D and 3D velocity profiles at meter-

scale resolution to depths of approximately 20 meters and for detecting shallow voids less than 10 

meters deep (Mirzanejad et al., 2020b; Tran et al., 2013). Despite these advantages, surface-based 

methods are limited by their ability to detect deeper voids due to the attenuation of seismic energy 

and the dominance of Rayleigh waves near the surface. Voids located deeper than five void 

diameters are typically undetectable by surface-based seismic techniques. 

Borehole-based seismic methods offer improved resolution and depth of investigation 

compared to surface-based approaches. Cross-hole seismic FWI techniques   (Pratt & Shipp, 1999; 

Wang & Rao, 2006; Zhou & Greenhalgh, 2003) have demonstrated exceptional capabilities for 

characterizing materials between boreholes. However, these methods require multiple boreholes 

for 3D characterization, making them expensive and logistically challenging. 

To address these limitations, a novel SPT-seismic method has been developed in this pro, 

combining the benefits of SPT testing with 3D FWI for deep site characterization (Mirzanejad et 

al., 2020b). In this approach, seismic wavefields are generated as the SPT hammer strikes the drill 

rod and sampler at various depths. These wavefields, dominated by body waves, are recorded using 

a 2D grid of geophones on the ground surface. Unlike surface-based sources that generate 

predominantly Rayleigh waves, the SPT-seismic method produces body waves that originate from 

within the rock mass and travel through deeper volumes of material before arriving at the surface. 

By inverting these body wave data, the method provides higher-resolution imaging and greater 

accuracy at depths beyond the reach of surface-based techniques. 
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The SPT-seismic method leverages the time-domain 3D FWI algorithm, previously 

developed under the FDOT-funded project BDV31-977-82. This algorithm, based on Gauss-

Newton optimization (GN-FWI) (Tran et al., 2019), achieves robust convergence and detailed 

subsurface imaging. However, its high memory requirements (>1.0 TB of RAM) have limited its 

use to specialized computing systems. To overcome this challenge, the algorithm has been adapted 

into a hybrid time-frequency domain approach in this project. Forward wave simulations are 

conducted in the time domain, while inversion is performed in the frequency domain, significantly 

reducing memory requirements by storing data for only a few dominant frequencies. This 

modification allows the inversion to run on standard desktop computers, significantly reducing the 

memory requirements while maintaining accuracy. The algorithm has been successfully tested on 

synthetic datasets and further optimized and validated using field experimental data. 

This SPT-seismic method enables high-resolution imaging of subsurface conditions over 

large volumes, detecting voids, characterizing soil and rock properties, and supporting the design 

of safe, efficient foundations. Its applications include sinkhole investigations, assessing variable 

site conditions, delineating problematic soils, and correlating geophysical results with engineering 

parameters for foundation design. 

1.2 Motivation and outline of the study 

 

For advanced geotechnical site characterization, we have developed a 3D SPT-seismic full-

waveform inversion (FWI) method that integrates SPT testing with advanced seismic imaging. 

The seismic waves generated by the SPT hammer impact are used as in-depth sources, producing 

body waves that travel through the subsurface and are recorded by surface geophones (Tran et al., 

2024). Unlike surface-based methods, which are dominated by surface waves and have limited 

resolution at depth, this approach leverages body waves originating from various depths, enabling 
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accurate imaging of subsurface structures over large volumes. This method significantly reduces 

the need for multiple boreholes and overcomes the depth limitations of traditional surface-based 

techniques. Additionally, parametric studies and field experiments ensure the optimization of test 

configurations and the reliability of the method under varied geologic conditions. 

The 3D SPT-seismic FWI method was first developed and validated using synthetic data 

(Chapter 2). Test configurations and SPT sampling intervals were subsequently analyzed to 

optimize both field testing and data processing strategies (Chapter 3). The method was then applied 

to field experiments conducted at three sites in Florida, with results verified against invasive tests 

(SPT) to ensure accuracy (Chapter 4). Finally, a user-friendly GUI software for the 3D FWI with 

SPT-source method was developed, along with a comprehensive user manual, to support future 

applications by FDOT (Chapter 5). 
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Chapter 2 – OPTIMIZATION OF 3D SPT- SEISMIC FWI 

COMPUTATIONAL ALGORITHM (TASK 1) 

 

2.1 Introduction 

 

This task focuses on enhancing the time-domain 3D FWI algorithm (previously developed 

under the FDOT-funded project BDV31-977-82) to make it compatible with regular desktop 

computers. To address the RAM limitations, the algorithm has been transformed from a purely 

time-domain approach into a hybrid time-frequency domain framework. In this approach, forward 

wave simulations are performed in the time domain, while the inversion process is carried out in 

the frequency domain. By storing data for only a few dominant frequencies, rather than thousands 

of time steps, the required memory is significantly reduced. This method assumes that a limited 

number of key frequency components can effectively represent the waveforms across the filtered 

frequency bandwidth. The newly developed time-frequency 3D FWI algorithm has been 

successfully tested using synthetic datasets based on realistic soil and rock profiles containing 

embedded voids.  

2.2 3D Seismic-SPT FWI algorithm 

 

The 3D FWI method has been enhanced to utilize the advantages of a hybrid time-

frequency domain approach. Forward wave simulations are performed in the time domain, 

enabling the simultaneous generation of wavefields at multiple frequencies without requiring an 

inverse matrix solver. The inversion process is then carried out using only a few selected dominant 

frequencies, significantly reducing the required computer memory (RAM).   
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2.2.1 Forward simulation in time domain 

 

Three-dimensional elastic wave propagation is modelled by a set of the first-order linear 

partial differential equations for isotropic materials (Equations 2-1 to 2-9). The first three equations 

govern the particle velocity vector, and the remaining equations govern the stress tensor: 

 
𝑣�̇� =

1

𝜌
(

𝜕𝜎𝑥𝑥

𝜕𝑥
+

𝜕𝜎𝑥𝑦

𝜕𝑦
+

𝜕𝜎𝑥𝑧

𝜕𝑧
) + 𝑓𝑥  (2-1) 

 
𝑣�̇� =

1

𝜌
(

𝜕𝜎𝑥𝑦

𝜕𝑥
+

𝜕𝜎𝑦𝑦

𝜕𝑦
+

𝜕𝜎𝑦𝑧

𝜕𝑧
) + 𝑓𝑦   (2-2) 

 
𝑣�̇� =

1

𝜌
(

𝜕𝜎𝑥𝑧

𝜕𝑥
+

𝜕𝜎𝑦𝑧

𝜕𝑦
+

𝜕𝜎𝑧𝑧

𝜕𝑧
) + 𝑓𝑧   (2-3) 

 
σ̇xx = (𝜆 + 2𝜇)

𝜕𝑣𝑥

𝜕𝑥
+ 𝜆 (

𝜕𝑣𝑦

𝜕𝑦
+

𝜕𝑣𝑧

𝜕𝑧
)   (2-4) 

 
σ̇𝑦𝑦 = (𝜆 + 2𝜇)

𝜕𝑣𝑦

𝜕𝑦
+ 𝜆 (

𝜕𝑣𝑥

𝜕𝑥
+

𝜕𝑣𝑧

𝜕𝑧
)   (2-5) 

 
σ̇𝑧𝑧 = (𝜆 + 2𝜇)

𝜕𝑣𝑧

𝜕𝑧
+ 𝜆 (

𝜕𝑣𝑥

𝜕𝑥
+

𝜕𝑣𝑦

𝜕𝑦
)   (2-6) 

 
σ̇xy = 𝜇 (

𝜕𝑣𝑥

𝜕𝑦
+

𝜕𝑣𝑦

𝜕𝑥
)   (2-7) 

 
σ̇xz = 𝜇 (

𝜕𝑣𝑥

𝜕𝑧
+

𝜕𝑣𝑧

𝜕𝑥
)   (2-8) 

 
σ̇yz = 𝜇 (

𝜕𝑣𝑦

𝜕𝑧
+

𝜕𝑣𝑧

𝜕𝑦
)  (2-9) 

Where the over-dot denotes the time derivative, (𝑣𝑥, 𝑣𝑦 , 𝑣𝑧) is the particle velocity vector, 

(𝑓𝑥 , 𝑓𝑦, 𝑓𝑧) is the body force vector, (𝜎𝑥𝑥, 𝜎𝑦𝑦, 𝜎𝑧𝑧 , 𝜎𝑥𝑦 , 𝜎𝑥𝑧 , 𝜎𝑦𝑧) is the stress tensor, 𝜌 is the mass 

density and μ, λ are Lamé’s coefficients. Lamé’s coefficients are calculated from S-wave and P-

wave velocities (Vs and Vp) as:   
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              𝜆 = 𝜌𝑉𝑃
2 − 2𝜌𝑉𝑠

2, 𝜇 = 𝜌𝑉𝑠
2                                                                      (2-10)  

Derivatives are discretized by using center finite differences. Assuming the equations are verified 

at the nodes, discretization leads to a velocity-stress staggered-grid as shown in Figure 2.1. The 

advantages of this technique include: (i) source insertion can be expressed by velocity or stress; 

(ii) a stable and accurate representation for a planar free-surface boundary is easily implemented; 

(iii) the algorithm can be conveniently implemented on scalar, vector, or parallel computers; (iv) 

signal filtering and boundary truncation can be implemented with minimum effort; and (v) 

wavefields at multiple frequencies can be generated simultaneously in the time-domain. 

 

 

Figure 2.1. Staggered 3-D grid 

 

With each time step, stresses and velocities are updated to simulate wave propagation. This is done 

by converting Equations 2-1 to 2-9 into their finite difference forms (Equations 2-11 through 2-

19). The explicit numerical scheme for calculating velocities and stresses is as follows: 
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where 𝑖, 𝑗, 𝑘 are the indicial location of the current point in the x, z, and y directions, respectively; 

𝑛 represents the current time step while 𝑈, 𝑉, and 𝑊 are the particle velocities in the x, z, and y 

directions (𝑣𝑥, 𝑣𝑦 , 𝑣𝑧). 𝐵 is the reciprocal of the density at the location indicated by the indices and 

𝑇 represent the stress component (e.g., 𝜎𝑥𝑥, 𝜎𝑦𝑦, 𝜎𝑧𝑧 , 𝜎𝑥𝑦, 𝜎𝑥𝑧 , 𝜎𝑦𝑧) in each direction. 𝑀 and 𝐿 are 

the Lame’s coefficients mentioned earlier.  
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In order to maintain stability of the simulation, the time interval (sampling rate) Δt must satisfy 

the Courant-Friedrichs-Levy (CFL) stability criterion. The numerical stability condition for this 

explicit scheme is: 

                               

1
1

222max 
++


zyx

tv

                            (2-20) 

Where 𝑣𝑚𝑎𝑥 is the maximum P-wave velocity of the medium, and Δx, Δy and Δz is the grid spacing 

selected to satisfy at least ten points per minimum expected wavelength to avoid numerical 

dispersion or: 

                        Δx, Δy, Δz ≤ dh =
𝜆𝑚𝑖𝑛

10
                                 (2-21) 

Where 𝜆𝑚𝑖𝑛 = 
𝑣𝑎𝑣𝑒

𝑓𝑚𝑎𝑥
, 𝑣𝑎𝑣𝑒  is the average S-wave velocity in the media, 𝑓𝑚𝑎𝑥 is the maximum 

frequency of the source. During inversion, Δt is allowed to change due to different 𝑣𝑚𝑎𝑥 values, 

which ensures that the measured wave fields are interpolated to the same sampling rate for 

comparison to the estimated wave fields at every iteration. Note, using a fixed small sampling rate 

will maintain stability of the simulation through iterations, but it will increase the required 

computing time. 

Special conditions are required at the boundaries of the modeled domain when simulating 

wave propagation with finite difference equations. A model without boundary conditions will have 

boundaries that act like rigid walls, i.e., all incoming waves will be reflect off of the boundary back 

into the domain. These reflections do not accurately represent the infinite media, from which data 

is collected in the field. An ideal model will allow the wave to pass through the boundary without 

any reflection.  For the domain, a free-surface boundary condition is applied on the top boundary 

(surface), while perfectly matched layers (PML) (Komatitsch & Martin, 2007) are applied at the 
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other boundaries (i.e., sides and bottom). The PML attenuates any waves near the boundary and 

the dampening effect is carried out by extending the staggered grid beyond the modelled domain. 

  

 
Figure 2.2. 3D wave propagation with and without the perfectly matched layer (PML) boundary 

truncation 
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As an example, Figure 2.2 shows 3D wave propagation in a homogeneous medium with 

(left) and without (right) the PML conditions. The source is located on the free surface 

(depth z = 0). With the implementation of the PML, almost no reflected signals from boundaries 

are observed (Figure 2.2, left column), whereas large, reflected signals from boundaries are seen 

after 0.3 s (Figure 2.2, right column) without the PML. 

 

2.2.2 Gauss-Newton inversion in frequency-domain   

 

To save computer RAM, the inversion is conducted in the frequency-domain. Time-domain 

wavefields and Jacobian elements obtained from the forward wave simulation (one shot at a time) 

are converted into the frequency-domain.  The time-domain components are replaced by those 

from the next shot simulation. The frequency-domain components (wavefields and Jacobian 

matrix) are stored for all shots at only three frequencies, instead of thousands of time steps.  This 

reduces the required RAM by about 90%. Using the approach of Butzer et al., (2013) based on the 

discrete Fourier transformation, signals are converted from the time domain to frequency domain 

as: 


=

−=
nt

l

ttlωlΔt)u(u
1

),(exp),(~ 1 xx 

                                                                   (2-22) 

where �̃�(𝑥, 𝜔) is the frequency-domain signal for the sampled location x = (x, y, z) and frequency 

ω, u(x, lΔt) is the time domain signal and time t = lΔt, Δt is the time sampling, and nt is the number 

of time steps. Each sampled location x is a receiver for wavefield or cells for Jacobian components. 

Equation 2-22 is used for all signals (estimated and measured wavefields, Jacobian matrix 

elements) in following Equations 2-23 to 2-25. Both real and imaginary components of the 
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transformed signals are used. It is noted that �̃�(𝑥, 𝜔) is the sum of time-domain data over time 

(e.g., stacking to improve signals), and thus it allows to analyze several SPT-blows at a similar 

depth (in case of low energy signals emitted from deep rock).  

The optimization method minimizes the residual between estimated and observed 

(measured) waveform data, which is defined as: 

∆�̃�s,r=�̃�s,r(m)-�̃�s,r                                                                                   (2-23) 

where s and r denote the shot and receiver numbers, respectively. The vector �̃�s,r(m) is the 

frequency-domain estimated data associated with the model m (Vs and Vp of all cells), and obtained 

from the forward simulation. The vector �̃�s,r(m) is the frequency-domain observed waveform data 

for field testing.  

The least-squares error E(m) is used for minimization of the residual as:  

E(m)=
1

2
‖∆�̃�‖

2
=

1

2
∆�̃�𝑡∆�̃�,  and  ∆�̃�={∆�̃�s,r , s=1..NS, r=1…NR}                      (2-24) 

where t denotes the matrix transpose, NS and NR are shot and receiver numbers, respectively. ∆�̃� 

is the residual for all shots and receivers, which are placed in a 2-D uniform grid on the ground 

surface. The size of the vector ∆�̃�s,r is 2 ×NF × NS × NR, where NF is the number of frequencies. 

The factor of 2 is for the real and imaginary components for each frequency. 

By minimizing the error E(m), the model m at iteration (n+1) is updated from the previous 

iteration as:                     

mn+1=mn - αn [J̃
𝑡
J̃ + λ1P𝑡P + λ2I𝑡I ]

−1

 J̃
𝑡
∆�̃�                                                     (2-25) 
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where the Jacobian matrix J̃ is the frequency-domain partial derivative wavefield with respect to 

individual parameters (Vs and Vp of cells). The time-domain partial derivative wavefield J is 

calculated based on the convolution of the virtual source with reciprocal wavefields (Tran et al., 

2019) and then converted to the frequency-domain J̃. The number of forward simulations required 

for the calculation of Jacobian J is NS+NR. I is the identity matrix, and matrix P is determined via 

a 3D Laplacian operator with its elements of either 1, -6 or 0. Coefficients λ1and λ2are 0.02 and 

0.0005 times of the maximum value of J̃
𝑡
J̃, respectively, as suggested by Tran et al. (2019). The 

term (λ1P𝑡P + λ2I𝑡I) in Equation 2-25 improves the invertibility of the approximate Hessian matrix 

(Ha = J̃
𝑡
J̃), and regularizes the inversion by constraining the model roughness (e.g., tying a cell to 

its six adjacent cells and larger λ1 producing smoother models). The step length  αn is fixed at 1.0 

in this study.  

2.3 Results 

The developed time-frequency 3D FWI algorithm of SPT-seismic data was first tested on 

a synthetic experiment with known Vs and Vp profiles to evaluate its accuracy, before applying to 

field experiments (Task 3). The synthetic experiment includes simulation of SPT-seismic data and 

inversion of the data to extract Vs and Vp for comparison to their true values.  

2.3.1 Synthetic experiment on a small model (20.4 m × 18 m × 18 m) 

 

The time-frequency 3D FWI algorithm of SPT-seismic data was first tested on a synthetic 

experiment. For this synthetic experiment, a challenging velocity model representing a variable 

subsurface profile with Vs of 200 m/s for the top layer and 400 m/s for the lower half space, with 

twice Vs for the Vp profile was used as the true model (Figure 2.3). Furthermore, a buried void of 

3 m × 3.75 m × 3.75 m (depth × length × width) was placed at 15 m depth and 1.0 m away from 
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the source line (or SPT location). It was placed to simulate a deep void that would not be found 

with an actual SPT. The void was assumed to be filled with air with Vs of 0 m/s and Vp of 300 m/s. 

A mass density of 1,800 kg/m3 is assumed for the whole medium, as a typical value for general 

soils.  

 

(a)                                                                        (b)  

                   
(c)                                                                         (d) 

 
 

Figure 2.3. Synthetic model with a void at 15 m depth: (a) the 3D rendering Vs model; (b) the 3D 

rendering Vp model; (c) the 2D cross-section view of Vs model; (d) the 2D cross-section view of 

Vp model  
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Figure 2.4. Test configuration: 36 receivers with spacing interval of 3.0 m, 18 sources with spacing 

interval of 1.2 m 

 

                                                                  

    
Figure 2.5. Initial model used for inversion 
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The test configurations are shown in Figures 2.4. A 2D array of 6 × 6 receivers at 3-m 

spacing (10 ft) was placed on the free surface, and a linear array of 18 sources at 1.2-m spacing 

was placed along a vertical line at the center. Shown in Figure 2.5 is the initial model used for 

inversion. A linearly increasing velocity model of 200 m/s at the ground surface to 400 m/s at the 

half space for the Vs and twice of that for the Vp was used as the initial model. 

Two inversions were conducted in order of increasing frequency data. The first inversion 

began with the initial model (Figure 2.5), using data at three frequencies of 15, 20, and 25 Hz. The 

second inversion ran with data at three frequencies of 30, 35, and 40 Hz, using the result of the 

first inversion as the input velocity model. Shown in Figure 2.6 is the variation of the normalized 

least-squares error with iterations for both stages of frequency inversion. The error decreased 

continuously during the first stage from 1.0 at the start of the lower frequency stage to about 0.02 

at the end of 100 iterations. The inversion algorithm was subsequently able to reduce the mismatch 

and reduced the error from 1.0 to 0.2 at the end of the second stage of an additional 100 iterations.  

 

Figure 2.6. Normalized least-squares error for both runs 
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Shown in Fig. 2.7 is a sampled waveform comparison between the observed data from the 

true model and estimated data associated with the initial model and the final inverted model at 

iteration 200. Figure 2.7a shows the discrepancy between observed and estimated data. This is due 

to the fact that estimated data is computed from the initial model (Figure 2.2) with no void and 

layer interface. Figure 2.7b shows the excellent match between observed and estimated data, 

because the model is significantly updated toward the true model during inversion. The waveform 

match improved substantially during inversion. Phase and amplitudes are matched perfectly at the 

end, indicating the success of the inversion algorithm that vectored towards the global minimum. 

The excellent match of observed and estimated data shows that a few dominant frequency 

components could well represent waveforms for the entire filtered frequency bandwidth. Matching 

data at 6 frequencies (15, 20, 25, 30, 35, and 40 Hz) allows matching the waveforms in the time-

domain for the entire filtered bandwidth from 10 to 50 Hz. In other words, there is a lot of 

redundant information in the time-domain waveforms, and only a few frequencies are needed for 

analysis to recover the true model.  

Shown in Figure 2.8 is the final inverted result. Both Vs and Vp profiles are well 

characterized. The existence of two separate layers is clearly observed, and the variable layer 

interface is well imaged. More importantly, the location and overall shape of the deep void is 

successfully identified. This synthetic result shows the advantage of using the in-depth source data 

(e.g., generated by a SPT-drill rod and spoon) for characterization of materials around the SPT 

boring and offline anomalies/voids.  
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(a) 

 
(b) 

 
 

Figure 2.7. Waveform comparison for a shot at 18-m depth: (a) observed data and estimated data 

associated with the initial model; (b) observed data and estimated data associated with the final 

inverted model 
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(a)                                                                          

    

(b) 

 

Figure 2.8. Small model: (a) 3D rendering of inverted Vs and Vp; (b) 2D cross-section view of 

inverted Vs and Vp 

 

2.3.2 Synthetic experiment on a large model (30 m × 24 m × 24 m) 

The 3D FWI algorithm was further tested on a large model with a deep void. For this 

synthetic experiment, a model of 30 m × 24 m × 24 m (depth × length × width) representing a 

variable subsurface profile was used as the true model (Figure 2.9). It has Vs of 200 m/s for the 

top layer and 400 m/s for the lower half space, with twice Vs for the Vp profile. A void of 3 m × 

3.75 m × 3.75 m (height × length × width) was buried at 18 to 21 m depth and 2.5 m away from 
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the source line. This offline void would not be found during an actual SPT. The void was assumed 

to be filled with air with Vs of 0 m/s and Vp of 300 m/s. A mass density of 1,800 kg/m3 is assumed 

to be for the whole medium, as a typical value for general soils.  

(a)                                                                         

       
(b) 

 
Figure 2.9. Large synthetic model with a deep void: (a) 3D rendering of true Vs and Vp; (b) 2D 

cross-section view of true Vs and Vp 

 

For waveform simulation and analyses, the test configuration (Figure 2.10) consists of 64 

receivers located in an 8×8 grid of 3-m spacing on the free surface, and 25 sources located from 0 

to 30-m depth at 1.2-m spacing along the center line of the model. A linearly increasing velocity 
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model of 200 m/s at the ground surface to 400 m/s at half space for the Vs and twice of that for the 

Vp was used as the initial model (Figure 2.11). 

 

 
Figure 2.10. Test configuration: 64 receivers with spacing interval of 3.0 m and 25 sources with 

spacing interval of 1.2 m 

 

       
 

Figure 2.11. Initial model used for inversion 
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Same as the previous analyses, two inversions were conducted for this large model. The 

first inversion began with the initial model (Figure 2.11), using data at three frequencies of 15, 20 

and 25 Hz. The second inversion ran with data at three frequencies of 30, 35 and 40 Hz, using the 

result of the first inversion as the input velocity model.  

The normalized least-squares error of iterations for both stages of frequency inversion are 

shown in Figure 2.12. The error decreased continuously during the first stage from 1.0 at the start 

of the lower frequency stage to about 0.02 at the end of the first stage. The inversion algorithm 

was subsequently able to reduce the mismatch and reduced the error from 1.0 to 0.15 at the end of 

the second stage.  

 
 

Figure 2.12. Normalized least-squares error for both inversion runs 
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Figure 2.13 compares the observed data from the true model and estimated data associated with 

the initial model and the final inverted model at iteration 200. Figure 2.13a shows the discrepancy 

between observed and estimated data. This is due to estimated data is computed from the initial 

model (Figure 2.11) with no void and layer interface. Figure 2.13b shows the excellent match 

between observed and estimated data, because the model is significantly updated toward the true 

model during inversion. The waveform match improved substantially during inversion. Phase and 

amplitudes are matched perfectly at the end, indicating the success of the inversion algorithm that 

vectored towards the global minimum. Again, the excellent match of observed and estimated data 

shows that a few dominant frequency components provide information for the entire frequency 

bandwidth.  

Shown in Figure 2.14 is the final inverted result. Both Vs and Vp profiles are well 

characterized in 3D domain within 12 m (40 ft) around the source line (SPT boring) to 30 m depth 

(100 ft). The two separate layers are recovered, and the variable layer interface are accurately 

imaged within the entire test area of 24 m × 24 m (80 ft × 80 ft). The offline void is identified with 

accurate location and shape. The results show the excellent capability of the time-frequency 3D 

FWI algorithm for characterizing materials around the SPT boring and offline anomalies/voids.  
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(a) 

 
(b) 

 
Figure 2.13. Waveform comparison for the 20th shot: (a) observed data and estimated data 

associated with the initial model; (b) observed data and estimated data associated with the final 

inverted model 
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(a)                                                      

  
(b)                                                                          

 
 

Figure 2.14. Large model: (a) 3D rendering of inverted Vs and Vp; (b) 2D cross-section view of 

inverted Vs and Vp 

 

2.4 Conclusion 

In this task, an advanced 3D SPT-seismic FWI algorithm is developed. Specifically, the 

forward wave simulation is done in the time-domain, while inversion is conducted in the 

frequency-domain. There are several advantages of this combined time-frequency approach. First, 

the wavefields are simulated at multiple frequencies simultaneously without an inverse matrix 

solver. Second, only a few frequency components are stored for each inversion analysis to 
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significantly reduce the required computer RAM by 90%, allowing the algorithm to run on a 

standard desktop computer (8 cores, 128 GB RAM). Finally, the frequency-domain data was the 

sum of time-domain data over time (e.g., stacking to improve signals), allowing analysis of several 

SPT-blows at a similar depth. This is particularly important for cases of low energy signals in deep 

rock. 

Before being applied to field experimental data, the developed algorithm was tested on two 

synthetic models (computational data) in this task. Both models represented the typical Florida 

geology with soils over highly variable limestone, together with embedded voids at 50 ft and 65 ft 

depths. Waveform data were generated using a 2D grid of sensors at 10-ft spacing on the surface 

and in-depth sources at 4-ft spacing along a vertical source line (e.g., SPT boring). The waveform 

data were then analyzed as if they were collected from field experiments. Results were then 

compared to the true models for assessment of the algorithm’s accuracy.  

Based on results of two synthetic experiments, the 3D SPT-seismic FWI algorithm showed 

excellent capabilities for characterizing materials around the SPT boring and offline voids or 

anomalies. Material properties (Vs, Vp) were well characterized in the 3D domain within 40 ft 

around the source line (SPT boring) to the depth of 100 ft (or SPT depth). In both experiments, the 

location and overall shape of deep voids were identified, and the variable layer interfaces were 

well imaged. The next steps were to optimize the algorithm to minimize field testing and data 

analyzing efforts (Task 2) and verify it on field experimental data (Task 3).  
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Chapter 3 – OPTIMIZATION OF FIELD-TESTING CONFIGURATIONS 

(TASK 2) 

3.1 Introduction 

The advanced 3D SPT-seismic FWI algorithm has been developed in Task 1. This task is 

to identify the optimal test configurations (receiver number and spacing, and source interval) for 

characterizing subsurface profiles in 3D domain with a single SPT. To achieve this, a number of 

parametric studies were performed with two synthetic (computational) models. For each model, a 

number of test configurations with different receiver spacings and SPT sampling intervals are used 

to simulate time-domain wavefields.  The wavefields are then converted to frequency domain and 

used for inversion analyses in order of increasing frequencies. Using low-frequency data requires 

a less detailed initial model and introducing high-frequency data gradually helps improve 

resolution of layering, anomalies, properties, etc. By examining the accuracy of inversion results 

from various test configurations, we can identify the optimal test configurations and SPT sampling 

intervals to minimize efforts of field testing and data analysis. Test configurations and required 

SPT sampling intervals identified in this task will be applied in field experiments in Task 3.  

For the parametric studies, two synthetic models (hypothetical soil/rock profiles) were 

designed to represent the typical Florida geological condition with soils underlain by variable 

bedrock. The two models cover surface areas of 60 × 60 ft and 80 × 80 ft, respectively, and depths 

up to 100 ft. For each model, a range of test configurations were tested. For the smaller model, 

four configurations were investigated with receiver grids of 4 × 4, 6 × 6, each with two SPT 

sampling intervals of 2 and 4 ft.  For the larger model of 80 × 80 ft surface area, four configurations 

were investigated with receiver grids of 4 × 4, 6 × 6, 8 × 8, and 10 ×10, with one SPT sampling 



29 

 

interval of 4 ft.  The accuracy and resolution of inverted profiles were compared among the 

simulations to identify the optimal test configurations. 

3.2 Model of 60×60-ft surface area 

3.2.1 Test configuration and analyses 

The developed 3D SPT-Seismic FWI algorithm was first tested on a model of 20.4 × 18 × 

18 m (68 × 60 × 60 ft), (depth × length × width). The velocity model representing a variable 

subsurface profile with Vs of 200 m/s for the top layer and 400 m/s for the lower half space, with 

twice Vs for Vp profile was used as the true model (Figure 3.1). Furthermore, a buried void of 3 × 

3.75 × 3.75 m (depth × length × width) was placed at 15 m depth (50 ft) and 1.0 m away from the 

source line (or SPT location). It was placed to simulate a deep void that would not be found with 

an actual SPT. The void was assumed to be filled with air with Vs of 0 m/s and Vp of 300 m/s.  

Four test configurations (Figures 3.2 to 3.5) were analyzed to investigate the optimal 

number and spacing interval of receivers and sampling interval of SPT blows that enabled a 

successful recovery of the subsurface features including the embedded void. The tests were carried 

out with an increasing number of receivers and sources.  Figures 3.2 and 3.3 show the sparse 

configuration including 16 receivers of 4 × 4 grid at 4.5 m (15 ft) spacing, and source intervals of 

1.2 m (4 ft) and 0.6 m (2 ft), respectively. Figures 3.4 and 3.5 show the dense configuration 

including 36 receivers of 6 × 6 grid at 4.5 m (10 ft) spacing, and source intervals of 1.2 m (4 ft) 

and 0.6 m (2 ft).  

Analyses were done in the same fashion for all four test configurations. A linearly 

increasing velocity model of 200 m/s at the ground surface to 400 m/s at the half space for Vs and 

twice of that for Vp was used as the initial model (Figure 3.6). For each test configuration, two 
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inversion runs were conducted with increasing frequency data. The first run began with the initial 

model (Figure 3.6), using data at three frequencies of 15, 20 and 25 Hz. The second run continued 

with data at three frequencies of 30, 35 and 40 Hz, using the result of the first run as the input 

velocity model. Both runs stopped after 100 iterations. It is noted that the 6 frequencies selected 

for analyses are based on the typical frequency range (10 to 40 Hz) of seismic data induced by 

SPT hammers. 

(a)                                                                        (b)  

                   
(c)                                                                          (d) 

 
 

Figure 3.1. Smaller synthetic model with a deep void: (a) 3D rendering of Vs; (b) 3D rendering of 

Vp model; (c) 2D cross-section view of Vs; (d) 2D cross-section view of Vp  
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Figure 3.2. Test configuration 1: 16 receivers of 4.5-m spacing and 18 sources of 1.2-m interval 

 
Figure 3.3. Test configuration 2: 16 receivers of 4.5-m spacing and 35 sources of 0.6-m interval 
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Figure 3.4. Test configuration 3: 36 receivers of 3.0-m spacing and 18 sources of 1.2-m interval 

 
Figure 3.5. Test configuration 4: 36 receivers of 3.0-m spacing and 35 sources of 0.6-m interval 
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(a)                                                                           (b) 

    
(c)                                                                            (d)  

 
 

Figure 3.6. Initial model used for all four test configurations: (a) 3D rendering of Vs; (b) 3D 

rendering of Vp; (c) 2D cross-section view of Vs; (d) 2D cross-section view of Vp 

 

3.2.2 Results for test configuration 1 (16 receivers at 15-ft spacing, 18 sources at 4-ft 

interval) 

To evaluate the algorithm’s performance, the misfit error and waveform comparisons are 

examined. The normalized least-squares error for all iterations of the two inversion runs are shown 

in Figure 3.7. The error decreased from 1.0 at the first iteration to about 0.01 at the final iteration 

of the first run, and to 0.06 in the second run.  The large reduction of error (99% for the first run, 

and 94 % for the second run) is a good measurement for the improvement of waveform fitting. It 
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is noted that the error jumped at the beginning of the second run at higher frequencies because the 

model is not yet appropriate to produce the recorded wave propagation of shorter wavelengths. 

Shown in Figure 3.8 is a sample waveform comparison between the observed data from 

the true model and estimated data associated with the initial model and the final inverted model at 

iteration 200. At the beginning of analysis, the clear discrepancy between observed and estimated 

waveform data was observed (Figure 3.8a). This was due to the fact that estimated data are 

computed from the initial model (Figure 3.6) with no void, no layer interface, and different Vs and 

Vp values from the true model. No reflected signals from the void and the layer interface existed 

in the estimated data, while the observed data contained such reflected signals.  

At the end of analysis, an excellent match between observed and estimated data was 

obtained (Figure 3.8b) because the model was updated toward the true model during inversion. 

The waveform match improved substantially during inversion. Phase and amplitudes were 

matched perfectly at the end. No cycle skipping or matching of wrong peaks was observed, 

indicating the success of the inversion algorithm that vectored toward the global minimum.  

The excellent match of observed and estimated data shows that a few dominant frequency 

components could well represent waveforms for the entire filtered frequency bandwidth. Matching 

data at 6 frequencies (15, 20, 25, 30, 35, and 40 Hz) allows matching the waveforms in the time-

domain for the entire filtered bandwidth from 10 to 50 Hz. In other words, there is a lot of 

redundant information in the time-domain waveforms, and only a few frequencies are needed for 

analysis. 

The final inverted Vs and Vp profiles are displayed in Figure 3.9. Even with the sparse test 

configuration of only 16 receivers, Vs profile (Figure 3.9 a) was well characterized. The existence 
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of two separate layers is clearly observed, and the variable layer interface is well imaged. More 

importantly, the location and overall shape of the deep void is successfully identified. However, 

the characterized Vp profile (Figure 3.9 b) is less accurate. While the void is imaged, several 

artifacts exist at shallow depths. This is due to the fact that there are not enough receivers to capture 

P-waves with longer wavelengths (twice S-wave wavelengths).  The 2D cross-section views of 

results (Figure 3.9 c and d) confirm that the variable layers and void are characterized by the 

algorithm.  

 
 

Figure 3.7. Test configuration 1: normalized least-squares error for both runs 
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(a) 

 
b) 

 
Figure 3.8. Test configuration 1: waveform comparison for a sample shot: (a) observed waveform 

and estimated waveform associated with the initial model; (b) observed waveform and estimated 

waveform associated with the final inverted model 
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(a)                                                                          (b) 

             

 (c)                                                                           (d) 

 

Figure 3.9. Results of test configurations 1 (16 receivers, 18 sources): (a) 3D inverted Vs; (b) 3D 

inverted Vp; (c) 2D cross-section view of inverted Vs; (d) 2D cross-section view of inverted Vp 

 

3.2.3 Results for test configuration 2 (16 receivers at 15-ft spacing, 35 sources at 2-ft 

interval) 

The inverted Vs and Vp profiles for test configuration 2 (16 receivers, 35 sources) are 

displayed in Figure 3.10. These results are very similar to those of test configuration 1 (Figure 

3.9), including the void and layer interface. The artifacts still exist in the Vp image (Figure 3.10b), 
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suggesting that increasing the number of sources does not improve the accuracy of inverted Vp. 

More receivers are needed to accurately capture P-wave propagation and inversion.  

(a)                                                                   (b) 

 

       

(c)                                                                            (d) 

 

 
 

Figure 3.10. Results of test configurations 2 (16 receivers, 35 sources): (a) 3D inverted Vs; (b) 3D 

inverted Vp; (c) 2D cross-section view of inverted Vs; (d) 2D cross-section view of inverted Vp 

3.2.4 Results for test configuration 3 (36 receivers at 10-ft spacing, 18 sources at 4-ft 

interval) 

Next, the inversion analysis was performed for the dense test configuration of 36 receivers 

at 10 ft spacing, and 18 sources at 4 ft interval, as shown in Figure 3.4. Normalized least-squares 
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error of the two inversion runs is shown in Figure 3.11, where the error reduced from 1.0 at the 

first iteration to about 0.02 at the end of the first run (iteration #100), and to 0.2 at the end of the 

second run (iteration #200). Waveform and residual comparisons are displayed in Figure 3.12. The 

inversion has drastically improved the waveform fitting from the initial stage (Figure 3.12a) to the 

final stage (Figure 3.12b). 

 

Figure 3.11. Test configuration 3: normalized least-squares error for two runs 

The inverted Vs and Vp profiles are displayed in Figure 3.13. As expected, for inverted Vs 

(Figure 3.13a), the layers are characterized, and the location and size of the void are recovered. 

For inverted Vp (Figure 3.13b), the layers and void are also characterized. There are still two small 

artifacts at shallow depths, but they are negligible. The result has been improved considerably 

compared to those in Figure 3.12b. The 2D cross-section views of results (Figure 3.13 c and d) 

confirm the variable layers and void are well characterized. This test configuration produces 

satisfying results for both Vs and Vp. 
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(a) 

 
(b) 

 
Figure 3.12. Test configuration 3: waveform comparison for the deepest source: (a) observed 

waveform and estimated waveform associated with the initial model; (b) observed waveform and 

estimated waveform associated with the final inverted model 
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(a)                                                                         (b)  

           

(c)                                                                           (d) 

 

Figure 3.13. Results of test configurations 3 (36 receivers, 18 sources): (a) 3D inverted Vs; (b) 3D 

inverted Vp; (c) 2D cross-section view of inverted Vs; (d) 2D cross-section view of inverted Vp 

3.2.5 Results for test configuration 4 (36 receivers at 10-ft spacing, 35 sources at 2-ft 

interval) 

The inverted Vs and Vp profiles for test configuration 4 (36 receivers, 35 sources) are 

displayed in Figure 3.14. These results are similar to those of test configuration 3 (Figure 3.13), 

including the void, layer interface, and true velocity values. Again, increasing the number of 

sources does not improve inverted results due to data redundancy.  
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(a)                                                                         (b) 

                  

(c)                                                                          (d) 

 

Figure 3.14. Results of test configurations 4 (36 receivers, 35 sources): (a) 3D inverted Vs; (b) 3D 

inverted Vp; (c) 2D cross-section view of inverted Vs; (d) 2D cross-section view of inverted Vp 

 

3.3  Model of 80×80-ft surface area 

3.3.1 Test configuration and analyses 

The developed 3D SPT-Seismic FWI algorithm was then tested on a larger model of 30 × 

24× 24 m (100 × 80 × 80 ft). The velocity model (Figure 3.15) represents a variable subsurface 

profile with Vs of 200 m/s for the top layer and 400 m/s for the lower half space, with Vp twice of 

Vs. An offline void of 3 m × 3.75 m × 3.75 m (depth × length × width) was placed at 19 m depth 

and 2 m away from the source line, thus it would not be found with an actual SPT. The void was 
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assumed to be filled with air with Vs of 0 m/s and Vp of 300 m/s. A mass density of 1,800 kg/m3 

is assumed to be for the whole medium, as a typical value for general soils.  

Figure 3.15. Larger synthetic model with a deep void: (a) 3D rendering of Vs; (b) 3D rendering of 

Vp model; (c) 2D cross-section view of Vs; (d) 2D cross-section view of Vp 

Four test configurations were analyzed to investigate the optimal number and spacing 

interval of receivers for successful recovery of the subsurface features. The analyses were carried 

out with an increasing number of receivers. The four configurations are shown in Figures 3.16 to 

3.19, with receiver grids of 4 × 4, 6 × 6, 8 × 8, and 10 ×10 and one SPT sampling interval of 4 ft. 

(a)                                                                        (b) 

       

(c)                                                                          (d) 
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As shown in the previous model, a smaller SPT sampling interval (2 ft) does not improve inversion 

results, thus only one SPT sampling interval of 4 ft was investigated for this larger model.  

Like the previous model, analyses for all four test configurations were conducted in the 

same fashion. A velocity model with Vs increasing from 200 m/s at the free surface (0-m depth) 

to 400 m/s at the model bottom (30 m depth) was used as the initial model (Figure 3.20). For each 

test configuration, two inversions were conducted with increasing frequency data. The first run 

began with the initial model (Figure 3.20), using data at three frequencies of 15, 20 and 25 Hz. 

The second run continued on data at three frequencies of 30, 35 and 40 Hz, using the result of the 

first run as the input velocity model. Both runs stopped after 100 iterations.  

 

Figure 3.16. Test configuration 5: 16 receivers at 6.75-m spacing and 25 sources at 1.2-m interval 
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Figure 3.17. Test configuration 6: 36 receivers at 4.5-m spacing and 25 sources at 1.2-m interval 

 
Figure 3.18. Test configuration 7: 64 receivers at 3.0-m spacing and 25 sources at 1.2-m interval 
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Figure 3.19. Test configuration 8: 100 receivers at 2.25-m spacing and 25 sources at 1.2-m interval 

(a)                                                                          (b) 

       
(c)                                                                            (d)   

 
Figure 3.20. Initial model used for all test configurations: (a) 3D rendering of Vs; (b) 3D rendering 

of Vp; (c) 2D cross-section view of Vs; d) 3D cross-section view of Vp 



47 

 

3.3.2 Results for test configuration 5 (16 receivers at 22.5-ft spacing, 25 sources at 4-ft 

interval) 

To assess the algorithm’s performance on this larger model, the misfit error and waveform 

comparison are examined. The normalized least-squares error of all iterations for test configuration 

5 are shown in Figure 3.21. The error reduced from 1.0 at the beginning to about 0.01 at the end 

of the first run, and to 0.07 in the second run. Shown in Figure 3.22 is the waveform comparison 

between the observed data from the true model and estimated data associated with the initial model 

and the final inverted model at iteration 200. The waveform match improved significantly during 

inversion from Figure 3.22a at the beginning to Figure 3.22b at the end of analyses. Both phase 

and amplitude match well at the end, indicating the inversion converges towards the global 

minimum. 

 

Figure 3.21. Test configuration 5: normalized least-squares error for both inversion runs 
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(a) 

 
(b) 

 
Figure 3.22. Test configuration 5: waveform comparison for the deepest source: (a) observed 

waveform and estimated waveform associated with the initial model; (b) observed waveform and 

estimated waveform associated with the final inverted model 
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(a)                                                                          (b)  

       
 

(c)                                                                            (d) 

 
 

Figure 3.23. Results of test configurations 5 (16 receivers, 25 sources): (a) 3D inverted Vs; (b) 3D 

inverted Vp; (c) 2D cross-section view of inverted Vs; (d) 2D cross-section view of inverted Vp 

The final inverted Vs and Vp profiles are shown in Figure 3.23. Even with the sparse test 

configuration of 16 receivers at a large spacing (22.5 ft), the algorithm can still characterize the 

two layers; the variable layer interface is imaged. However, the void is not characterized with the 

correct size. Inversion artifacts are shown at shallow depths in both Vs and Vp images (Figure 3.23 

a and b). The 2D cross-section views of results (Figure 3.23 c and d) show the variable layer 

interface and an anomaly at the void location. However, the inverted Vs of the void is only about 

200 m/s, which is much higher than its true velocity of zero. More receivers are needed to capture 

both S-wave and P-wave components for accurate inversion results.   
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3.3.3 Results for test configuration 6 (36 receivers at 15-ft spacing, 25 sources at 4-ft 

interval) 

The inverted Vs and Vp profiles for test configuration 6 are shown in Figure 3.24. 

Compared to the results (Figure 3.23a) of test configuration 5, Vs profile (Figure 3.24a) is 

characterized much better without inversion artifacts. The void is characterized with good accuracy 

of its location and size. However, significant artifacts still exist in the Vp image, because the 

receiver grid is too sparse to capture P-waves with longer wavelengths.  The 2D cross-section 

views of results (Figure 3.24 c and d) confirm that the variable layers and void are characterized. 

This test configuration only produces good results for Vs profile, but not Vp profile. 

(a)                                                                          (b) 

     
 

(c)                                                                            (d) 

 
 

Figure 3.24. Results of test configurations 6 (36 receivers, 25 sources): (a) Inverted 3D Vs model; 

(b) Inverted 3D Vp model; (c) 2D cross-section view of inverted Vs model; (d) inverted 2D cross-

section view of inverted Vp model  
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3.3.4 Results for test configuration 7 (64 receivers at 10-ft spacing, 25 sources at 4-ft 

interval) 

The inverted Vs and Vp profiles for test configuration 7 are shown in Figure 3.25. As 

expected, Vs profile (Figure 3.25a) is well characterized. The layer interface and the void are 

characterized with good accuracy. Regarding Vp file (Figure 3.25b), there is a considerable 

improvement compared to the Vp result (Figure 3.24b) of test configuration 6.  Most of artifacts 

were eliminated with this denser test configuration. The 2D cross-section views of results (Figure 

3.24 c and d) confirm the variable layers and void are characterized. Test configuration 7 produces 

satisfying results for both Vs and Vp profiles. 

(a)                                                                        (b) 

  
(c)                                                                          (d) 

 
Figure 3.25. Results of test configurations 7 (64 receivers, 25 sources): (a) Inverted 3D Vs model; 

(b) Inverted 3D Vp model; (c) 2D cross-section view of inverted Vs model; (d) inverted 2D cross-

section view of inverted Vp model 
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3.3.5 Results for test configuration 8 (100 receivers at 7.5-ft spacing, 25 sources at 4-ft 

interval) 

 

(a)                                                                          (b) 

  
(c)                                                                            (d) 

 
 

Figure 3.26. Results of test configurations 8 (100 receivers, 25 sources): (a) Inverted 3D Vs model; 

(b) Inverted 3D Vp model; (c) 2D cross-section view of inverted Vs model; (d) inverted 2D cross-

section view of inverted Vp model 

 

Finally, the inverted results for the densest configuration of 100 receivers are shown in 

Figure 3.26. Both Vs and Vp profiles are well characterized in terms of the layer interface, void 

location and size, as well as the true velocity values. Compared with the previous cases with fewer 

receivers, this densest test configuration provides the best results, without any inversion artifacts 

in both Vs and Vp profiles.  The 2D cross-section views of results (Figure 3.24 c and d) clearly 
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show the two variable layers and the void. While excellent results are obtained with this dense test 

configuration, significant computing time (2 days) is required. As the computer time is 

proportional to the sum of numbers of sources and receivers, using 100 receivers increases the 

computer time by 30 % compared to that of 64 receivers, and by 100% compared to that of 36 

receivers. 

3.3.6 Summary 

The 3D SPT-Seismic FWI algorithm was tested on a large model (100 x 80 x 80 ft), using 

four test configurations with 16 receivers (22.5 ft spacing), 36 receivers (15 ft spacing), 64 

receivers (10 ft spacing), and 100 receivers (7.5 ft spacing), and a SPT source interval of 4 ft. By 

examining inverted results, the algorithm requires the receiver spacing of 15 ft or less for 

recovering Vs profile, and the receiver spacing of 10 ft or less for recovering Vp profile. Based on 

accuracy of results and computing demand, the receiver spacing of 10 ft and source interval of 4 

ft is also recommended for this large model. The receiver spacing of 15 ft can also be used if only 

Vs profile is needed.  

3.4 Conclusion 

This task was to find the minimum number of receivers (max spacing) and sources (max 

sampling interval) that enabled a successful characterization of variable layers and embedded 

voids by the 3D SPT-seismic algorithm developed in Task 1. Several test configurations of various 

spacing intervals of receivers and sources were analyzed. The configurations were tested on two 

synthetic models with variable soil/rock layers and embedded voids. Accuracy and resolution of 

inverted Vs and Vp profiles were compared between simulations to identify the optimal test 

configuration. 
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The analyses were first performed on a smaller model of 68 × 60 × 60 ft (depth × length × 

width) with variable layers and an offline void. Four test configurations with 16 receivers (15-ft 

spacing) and 36 receivers (10-ft spacing), and each with two SPT source intervals of 4 ft and 2 ft 

were investigated. In all 4 cases, the Vs profile was well characterized by the algorithm, including 

variable layers as well as location and size of the void. However, the receiver spacing of 15 ft 

produced inversion artifacts in Vp image. Interestingly, due to data redundancy, the source interval 

of 2 ft did not improve inverted results, compared to those with the source interval of 4 ft. Thus, 

analyzing SPT sampling intervals smaller than 4 ft was not necessary.  

The inversion analyses were then performed on a larger model of 100 × 80 × 80 ft (depth 

× length × width), also with variable layers and an offline void. Four test configurations with 16 

receivers (22.5-ft spacing), 36 receivers (15-ft spacing), 64 receivers (10-ft spacing), and 100 

receivers (7.5-ft spacing), and SPT source interval of 4 ft were tested. By examining inverted 

results, the SPT-seismic algorithm requires the receiver spacing of 15 ft or less for recovering Vs 

profile, and the receiver spacing of 10 ft or less for recovering Vp profile.  

Based on accuracy of results and computing demand for all eight test configurations, the 

receiver spacing of 10 ft and SPT source interval of 4 ft is recommended. The receiver spacing of 

up to 15 ft can be used if only Vs profile is needed (Vp is less accurate). For field experiments, SPT 

sampling at 2- to 4-ft intervals should be used, in cases where averaging data to enhance signal-

to-noise ratio or removing blows with poor data is required. These optimal test configurations will 

be applied to field experiments in Task 3.  
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Chapter 4 – VERIFICATION OF 3D SPT-SEISMIC FWI ALGORITHM AT 

FIELD TEST SITES (TASK 3) 

 

4.1 Introduction 

This task is to validate the 3D SPT-seismic Full Waveform Inversion (3D SPT-seismic 

FWI) algorithm, developed in Task 1, to assess its efficacy in identifying voids away from SPT 

locations and characterizing variable soil/rock layers. Field experiments were conducted at 3 test 

sites (Newberry, Bell, and Kanapaha) for the validation. For each test site, a 2D grid of geophones 

were deployed on the ground surface to record seismic waves generated by a SPT hammer at 

depths. The optimal test configurations (geophone spacing and SPT sampling intervals) identified 

in Task 2 were used for field experiments in this task. Recorded SPT-seismic data were analyzed 

by the 3D SPT-seismic FWI algorithm, and results were compared to SPT-N values for assessment 

of the method’s capability.  Key outcomes of this task included the 3D visualization of seismic 

results, illustrating soil/rock layering, pinnacles, and void identification. Details on data 

acquisition, analysis, visualization, and validation are provided in subsequent sections. 

4.2 Newberry site  

The field experiments were first conducted at Newberry site (Fig. 4.1a). It is a dry retention 

pond, consisting of fine sand and silt layers underlain by weathered and karst limestone. The top 

of limestone is typically from 2 to 10-m depth over the site, with exception of a few locations 

where limestone is seen on the ground surface. The site is prone to sinkhole activity, and a number 

of voids have been found at shallow depths of a few meters (Mirzanejad et al., 2020a).  
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(a) 

 

(b) 

 

Figure 4.1. Field experiment at Newberry site: (a) two test zones with an SPT at the center of each 

zone; (b) site photo with the SPT rig 

4.2.1 Data acquisition 

Data acquisition was performed for two test zones of 36 × 18 m (120 × 60 ft), each with an 

SPT at the center as shown in Fig. 4.1a. For each zone, 72 vertical geophones of 4.5-Hz resonance 

frequency were used on the ground surface, covering a 6 × 12 grid of 3 m spacing as shown in Fig. 

4.2. This test configuration was selected based on our parametric studies (Task 2). A 2D grid of 

geophones at 3 m (10 ft) spacing (or less) is required to achieve acceptable accuracy and desired 

resolutions at submeter pixels.  

The SPT rig was used as the seismic source. For each source location at depth, the 140-lb 

SPT hammer was dropped 30 inch, striking the top of SPT rod (above the ground surface), and 

imparting energy that propagated to the SPT spoon (attached at the end of SPT rod), which acted 
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as the in-depth seismic source and induced seismic wavefields at depths. At each hammer strike 

(blow), the seismic trigger, mounted on the SPT rod, activated the seismograph for data recording.  

SPT#1 was conducted to 18.9-m depth (63 ft), with intervals of 0.45 m (1.5 ft) above 6-m 

depth (20 ft) and 1.5 m (5 ft) below 6-m depth (20 ft). SPT-seismic data were recorded for 5 to 10 

blows at each interval, for a total of 146 blows from the ground surface to the bottom of boring. 

From about 13 to 17 m depth (43-56 ft), the weight of hammer was recorded for the SPT blow 

counts (N = 0), suggesting a void that could be partially filled with raveled soils. It is noted that 

no seismic data were recorded at the void depth.  

 

 
Figure 4.2. Test configuration used for each test zone, with 72 geophones placed on the ground 

surface in a 6 × 12 grid of 3-m spacing and SPT at the center of the geophone array 
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Similar to zone 1, SPT#2 was conducted to a depth of 18.10 m (60 ft) at intervals of 0.45 

m (1.5 ft) above 6-m depth (20 ft) and 1.5 m (5 ft) below 6-m depth (20 ft). Seismic data were 

recorded for 102 blows from the ground surface to the maximum SPT depth, with 5 to 10 blows 

at each SPT interval. From about 5 to 9 m depth, the weight of rod or weight of hammer were 

recorded (SPT-N values = 0), suggesting that a void filled with air and some raveled soils. In 

addition, a complete loss of drilling fluid circulation happened at 17.1-m depth (57 ft), suggesting 

another void.  

Shown in Figure 4.3 is the measured field data for the deepest source at 18.9-m depth (63 

ft). The data were filtered through 10-40 Hz bandwidth (Figure 4.3a) with the corresponding 

frequency spectra (Figure 4.3b). The wavefield emitted from this deep source location arrived at 

all receivers with a consistent propagation pattern in both magnitude and phase. It suggests that 

the SPT hammer provided sufficient wave energy at the depth required for propagating over large 

distances (26 m to the farthest geophone) to the ground surface. A similar quality of measured data 

was obtained for most blows.  

 
Figure 4.3. Field experimental data for the deepest source at 63-ft depth 



59 

 

4.2.2 Data analysis 

Test zone 1 

For inversion, the analyzed medium of 24 × 36 × 18 m (80 × 120 × 60 ft, depth × length × 

width) was discretized into cells of 0.60 × 0.75 × 0.75 m (2 × 2.5× 2.5 ft, depth × length × width). 

The source locations (actual depths of SPT spoon) were assigned to nearest numerical nodes (0.6- 

m vertical spacing) for wave simulation. One hundred forty-six blows were assigned to 20 depths, 

and data from blows at the same depth were averaged to enhance signal quality.  

Based on the spectral analysis of surface data at the site, a 1D initial velocity model (Fig. 

4.4) was taken with Vs linearly increasing from 200 m/s for soil on the surface and to 500 m/s for 

limestone at the model bottom (24-m depth). The initial Vp was assumed to be twice the initial Vs. 

The inversion started on the initial model (Fig. 4.4) using waveform data filtered through 10-40 

Hz bandwidth. The inversion stopped at a preset maximum number of iterations (100 iterations) 

and took about 26 hours on a desktop computer (32 cores of 3.4 GHz, and 512 GB of RAM). 

 

Figure 4.4. Initial Vs used for inversion of data from both test zones, and initial Vp as 2 × Vs (not 

shown) 
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(a)

 

(b) 

 

Figure 4.5. Test Zone #1 — Waveform comparison between observed and estimated data for two 

sources: (a) 11.0 m depth (just above the void) and (b) 18.9 m depth (deepest source). Data from 

two poor channels were excluded from the analysis. 

Figure 4.5 is the comparison of waveform data for two source locations at 11-m (36 ft) 

depth (above the void) and 18.9-m (63 ft) depth (deepest source). The estimated and observed 

(measured) data matched well at the end of analysis. No cycle skipping (matching of wrong peak) 

is observed, confirming that inversion converged to the global minimum. Figure 4.6 shows the 

normalized error for all 100 iterations. The error reduced continuously from 1.0 at the beginning 

to 0.67 at the end of analysis. The remaining error (waveform misfit) is due to the fact that the 

field conditions (noise, damping, soil/rock properties) were not fully captured by the forward 
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simulation and model update. Nevertheless, the final estimated data mimics the field data (Fig. 

4.5). 

 

Figure 4.6. Test zone #1: normalized least-squares errors of all 100 iterations 

 

Shown in Fig. 4.7 are the final inverted results. Vs profile (Fig. 4.7, left) contains two 

distinct layers: 1) a soft layer with Vs ~ 200 m/s from 0 to about 7-m depth (0 to 23 ft) and 2) a 

stiff layer with Vs ~ 500 m/s from 7 to 24-m depth (23 to 80 ft). They agree with the material 

samples from SPT with soil underlain by limestone. Importantly, a large low-velocity zone (Vs 

~100 m/s) is found at the middle of medium from about 13 to 17 m depth (43 to 56 ft). The Vp 

profile (Fig. 4.7, right) is similar to the Vs profile, including the existence of the low-velocity zone 

and soil/limestone layers.  
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The 3D rendering of inverted Vs and Vp are shown in Figure 4.8. Both profiles exhibit the 

shallow soil layer underlain by the limestone layer. The top of limestone varies from 6 to 8 m depth 

(20-27 ft) below the test area of 36 × 18 m (120 × 60 ft). In Fig. 4.8 a, two separate voids are 

imaged in the middle of medium near 15-m depth (50 ft). One void intersects with the SPT 

borehole; the other void is off-line and was not identified by the SPT. Vp image (Fig. 4.8 b) is 

consistent with Vs image. Compared to the 1D SPT, the seismic results provide much more 

information on the subsurface profile such as locations and 3D dimensions of voids and 3D soil or 

rock variation.  

 

 
 

Figure 4.7. Newberry test zone #1: 2D cross-section view of inverted Vs and Vp 
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(a) 

 

(b) 

 

Figure 4.8. Newberry test zone #1: 3D rendering of inverted Vs (a) and Vp (b) 
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Test zone 2 

 

Data analysis was performed in the same manner as that of zone 1. The analyzed medium 

of 24 × 36 × 18 m (80 × 120 × 60 ft in depth × length × width) with cells of 0.60 × 0.75 × 0.75 m 

(2 × 2.5× 2.5 ft in depth × length × width) were used. The 102 blows were assigned to 19 depths, 

and data from blows at the same depth were averaged to reduce noise and improve signal quality. 

The inversion started on the same initial model (Fig. 4.4) using 10-40 Hz data and stopped after 

100 iterations.  

 

Figure 4.9. Newberry test zone #2: 2D cross-section view of inverted Vs and Vp 
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(a) 

 
 

(b) 

 
 

Figure 4.10. Newberry test zone #2: 3D rendering of inverted Vs (a) and Vp (b) 
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The final inverted results are shown in Fig. 4.9. Vs profile (Fig. 4.9, left) consists of a soft 

layer with Vs ~ 200 m/s from 0 to about 5-m depth (0 to 17 ft), and limestone layer below 5-m 

depth (17 ft). It contains a large low-velocity anomaly (Vs <100 m/s) at shallow depths (5-10 m) 

and a deeper low-velocity anomaly (Vs <150 m/s) at below 15-m depth (50 ft). Vp profile (Fig. 

4.9, right) is similar to Vs profile, regarding the soil/rock layers and low-velocity anomalies. For 

better visualization, Figure 4.10 shows 3D rendering of inverted Vs and Vp. Both profiles exhibit 

the shallow soil layer underlain by the limestone layer.  The large low-velocity anomaly is clearly 

imaged at between 5 to 10 m depth (17 to 33 ft), and the deep anomaly is also shown at about 17 

m depth (56 ft). 

4.2.3 Verification 

The comparison of inverted Vs to SPT-N values at the two SPT locations is shown in Fig. 

4.11. For test zone 1, Figure 4.11a shows the initial and inverted Vs profiles at the SPT location, 

together with SPT-N (blow counts) values of SPT 1. Apparently, Vs values changed significantly 

during the inversion. At the void location from 13-17 m depth (43 to 56 ft), the cell Vs changed 

from the initial values of about 400 m/s to the final values of about 120 m/s. The final Vs profiles 

generally agree with SPT-N values, including a high-velocity zone about the void at 10-12 m depth 

(33-40 ft), and the low-velocity zone at the void location of 13-17 m depth (43 to 56 ft). 

For test zone 2, the initial and inverted Vs profiles at the SPT location are shown in Fig. 

4.11b, together with SPT-N values of SPT 2. The good agreement between inverted Vs and SPT-

N values is observed from the ground surface to 13-m depth (43 ft). Both profiles show low values 

from 5 to 10 m depth (17-30 ft) at the void location, and high values at about 3-m (10-ft) and 13-

m (43-ft) depths. While there exist discrepancies between Vs and SPT-N values below 13-m depth 
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(43 ft), the complete loss of drilling fluid circulation at 17.1-m depth (57 ft) suggests that the SPT 

is next to the offline void in rock (shown as the deep anomaly in Fig. 4.10).  

 However, the SPT-N values are more erratic than the Vs for both SPTs. This is due to the 

SPT-N values representing the local soil properties at the device’s tip, while Vs values represent 

average material properties of a 0.60 × 0.75 × 0.75 m (2 × 2.5× 2.5 ft) cell. In addition, the 

regularization used in Eq. 5 tends to tie a cell to its 6 adjacent cells (top, bottom, left, right, front 

and back), leading to smooth inverted models. Nevertheless, the SPT-seismic FWI was able to 

detect buried voids and characterize the subsurface soil/rock properties over large 3D volumes. 

 

(a) 

 

(b) 

 
Figure 4.11. Newbery site: comparison of Vs with SPT N-values: (a) SPT 1 and (b) SPT 2 
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4.3 Bell site 

4.3.1 Data acquisition 

 

 
Figure 4.12. Field experiment at Bell site: test site photo with the SPT. The 72 geophones (6 × 12 

grid) were placed over a test area of 60 x 120 ft. The SPT location is at the center of the test area  

 

The SPT-seismic FWI method was subsequently tested at the Bell site (Fig. 4.12). The data 

acquisition involved deploying 72 vertical geophones with a resonance frequency of 4.5 Hz across 

a 6 × 12 grid with 3 m (10 ft) spacing, as depicted in Fig. 4.2. Using the SPT rig as a seismic 

source, the 140-lb SPT hammer was dropped from a height of 30 inches, impacting the top of the 

SPT rod above the ground surface. This impact transferred energy, propagating to the SPT spoon 
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attached at the end of the rod, functioning as the in-depth seismic source. The SPT spoon induced 

seismic wavefields at various depths. With each hammer strike, the seismic trigger mounted on 

the SPT rod activated the seismograph for data recording. The recording process encompassed 116 

blows, ranging in depth from 0 to 15.24 m (0-51 ft), providing a comprehensive dataset for 

subsequent analysis. 

4.3.2 Data analysis 

 

Data from all 116 blows from the ground surface to 15.24-m depth (51 ft) were used for 

analysis. Figure 4.13 shows the measured data for the deepest source. The data were filtered 

through a 5-40 Hz bandwidth. The wavefield displays a consistent propagation pattern in both 

magnitude and phase across most receivers. A similar quality of measured data was observed for 

all other shallower source locations, ensuring reliability and coherence throughout the dataset. 

 

 
 

Figure 4.13. Bell site: experimental data for the deepest source at 51-ft depth 
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For the inversion process, the analyzed medium is 24 × 36 × 18 m (depth × length × width). 

Source locations, corresponding to the actual depths of the SPT spoon, were assigned to the nearest 

numerical nodes with vertical spacing of 0.61 m or 2 ft for wave simulation. The 116 blows were 

distributed across 15 depths from 0 to 15.24 m (0-51 ft) at intervals of 0.45 m (1.5 ft) or 1.5 m (5 

ft), as illustrated in Fig. 4.14. To enhance signal quality, data from blows at the same depth were 

averaged. 

 

 
Figure 4.14. Field experiment test configuration with sources (red triangle) and receivers (cyan 

circle) 
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Following spectral analysis of the data, a 1D initial velocity model (Fig. 4.15) was 

established, with Vs linearly increasing from 200 m/s for surface soil to 400 m/s for limestone at 

the model bottom. The initial Vp was assumed to be twice that of the initial Vs. The inversion 

commenced with the initial model (Fig. 4.15), using waveform data filtered through a 10-35 Hz 

bandwidth. The stopping criteria were set as that the inversion stopped at the maximum number 

of iterations (100 iterations), or when the error changed by less than 0.1% from the previous 

iteration for three consecutive iterations.  

 

 

 

Figure 4.15. Initial Vs used for inversion, and initial Vp as 2 × Vs (not shown) 
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A detailed comparison between the estimated and observed (field) data is shown in Fig. 

4.16 for the deepest source at 51 ft depth. The strong agreement between the estimated and field 

data confirms the accuracy of the analysis. Importantly, no cycle skipping affirms that the analysis 

converged to the global solution. 

 

Figure 4.16. Field experiment: waveform comparison between observed data and estimated data) 

for the deepest source at 51-ft depth. Poor channels are removed from analysis 

 

In Fig. 4.17, the normalized error for all iterations is depicted, revealing a consistent 

reduction from 1.0 at the start to 0.74 at the conclusion of the analysis. The remaining error is 

attributed to the fact that the field conditions including noise, damping, and soil/rock properties, 

were not entirely captured by the forward wave simulation. Despite these challenges, the final 

estimated data closely mimics the field data, as illustrated in Fig. 4.16. 
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Figure 4.17. Bell site: normalized least-squares errors of all 100 iterations 

 

The final inverted results are shown in Fig. 4.18. The Vs profile (Fig. 4.18, left) delineates 

five distinct layers: 1) a stiff layer (Vs ~250 m/s) near the ground surface, 2) two soft layers (Vs 

~150 m/s) at about 3 to 5 m depth (10-17 ft) and 12 to 17 m depth (40-57 ft), and 3) two stiff layers 

(Vs ~550 m/s) at 6 to 12 m depth (20-40 ft) and at the bottom. The Vp profile (Fig. 4.18, right) 

mirrors the Vs profile.  

As shown in Fig. 4.19, the 3D rendering of the inverted Vs and Vp profiles illustrates a soft 

soil layer overlaying the limestone layer. The limestone layer varies from 6 to 15 m below the 

surface in the test area of 36 × 18 m. The soft layers are distinctly visualized as the blue zone in 

the figure. 
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Figure 4.18. Bell site: 2D cross-section view of inverted Vs and Vp 

 

(a) 
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(b) 

 
Figure 4.19. Bell site: 3D rendering of inverted Vs (a) and Vp (b) 

 

4.3.3 Verification 

Figure 4.20 depicts the initial and final inverted Vs profiles at the SPT location, 

accompanied by SPT-N (blow counts) values. Vs values changed significantly during inversion 

from the initial values to the final values, suggesting the algorithm is robust. The final inverted Vs 

profiles well correlate with SPT-N values, revealing a high-velocity zone at 6-15m depth and a 

low-velocity zone between 15-17 m depth. The SPT-seismic FWI effectively characterizes 

subsurface soil/rock stratigraphy and properties, providing valuable insights into the presence of a 

soft material zone beyond the boring depth. 
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Figure 4.20. Comparison of inverted Vs with SPT N-values 

 

4.4  Kanapaha site  

4.4.1 Data acquisition 

The SPT-seismic FWI method was then tested at Kanapaha site, Florida (Fig. 4.21). The 

same test equipment and configuration as those of the previous sites were used for this site. Data 

acquisition involved the deployment of 72 vertical geophones, arranged in a 6 × 12 grid at 3-meter 

spacing (10 ft), as illustrated in Fig. 4.2. One SPT was conducted at the center of the test area down 

to 17.4 m (58 ft). SPT-seismic data were recorded for 100 blows from 0 to 17.4 m depth (0-58 ft), 
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providing a complete dataset for analysis. Weight of hammer was recorded at about 11 m (34 ft 

depth), suggesting a small void or very soft material exists.  

 
 

Figure 4.21. Field experiment at Kanapaha site: photo with the SPT rig. The 72 geophones (6 × 12 

grid) were placed over a test area of 60 x 120 ft. The SPT location is at the center of the test area 

 

4.4.2 Data analysis 

All data from 100 blows were used for analysis. Figure 4.22 depicts the collected data from 

the first source on the ground surface. The wavefield exhibited a consistent propagation pattern in 

both magnitude and phase across the geophone array. The analyzed medium is 24 × 36 × 18 m (80 

× 120 × 60 ft in depth × length × width). Source locations, aligned with the actual depths of the 
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SPT spoon, were assigned to the nearest numerical nodes with a vertical spacing of 0.60 m (2 ft) 

for wave simulation. The 100 blows were distributed at 15 depths ranging from 0 to 17.4 m (0-58 

ft). Data from blows at the same depth were averaged to enhance the quality. 

 
Figure 4.22. Field experimental data for a sample source on the surface 

 

Based on spectral analysis of measured data, a 1D initial velocity model was estimated as 

shown in Fig. 4.23. In this model, the S-wave velocity (Vs) linearly increases from 200 m/s for 

surface soil to 400 m/s for limestone at the model bottom. The initial P-wave velocity (Vp) was 

assumed to be twice the initial Vs. The inversion began with the initial model shown in Fig. 4.23, 

utilizing waveform data filtered within a 10-40 Hz bandwidth. The inversion process concluded 

after 100 iterations. 
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Figure 4.23. Initial Vs used for inversion, and initial Vp as 2 × Vs (not shown) 

 

Figure 4.24 shows the normalized errors, which decreased from 1.0 at the beginning to 

0.75 at the end of analysis.   Figure 4.25 shows a comparison between the observed and estimated 

data for two source locations. A good agreement between the final estimated and field data was 

obtained. No cycle skipping (matching of wrong peak) is seen, suggesting the analysis converges 

to the global solution. 

 

Figure 4.24 Kanapaha site: normalized least-squares errors of all 100 iterations 
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(a) 

 

(b) 

 

Figure 4.25. Field Experiment — Waveform comparison between observed and estimated data: 

(a) first source (surface source); (b) deepest source at 17.4 m (58 ft). Poor channels were excluded 

from the analysis 
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Figure 4.26 presents the final inverted results. The Vs profile delineates a soil layer (Vs 

~200 m/s from surface to about 10-m depth (30 ft), underlain by variable limestone layers with Vs 

> 500 m/s. Notably, a small void is effectively characterized with low Vs values (~ 100 m/s) at 10-

12 m depth, which was confirmed by SPT data (around 11 m depth). The Vp profile mirrors the Vs 

profile, delineating the void and the soil/limestone layers.  

 The 3D rendering of the inverted Vs and Vp profiles portrays a shallow soil layer over the 

limestone layer. The top of the limestone layer exhibits variation, ranging from 10 to 13 m (33-43 

ft) below the surface within the test area of 36 × 18 m (120 × 60 ft). The soft layer is clearly 

visualized as the blue zone in the figure. 

 

 
Figure 4.26. Kanapaha site: 2D cross-section view of inverted Vs and Vp 
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(a) 

 
 

(b) 

 
Figure 4.27 Kanapaha site: 3D rendering of inverted Vs (a) and Vp (b). The anomaly is clearly 

shown as the blue zone near the middle in Vs profile 
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4.4.3 Verification  

Figure 4.28 shows both the initial and final inverted Vs profiles at the SPT location, 

accompanied by SPT-N (blow counts) values. The final Vs profile well agrees with SPT-N values, 

including low-velocity zones between 1.5-4 m depth (5-13 ft) and 10-12 m depth (33-40 ft), a 

medium-velocity zone near the ground surface and 4-10 m depth (13-33 ft), and a high-velocity 

zone (limestone) below 12-m depth (40 ft). The very low Vs value (~ 100 m/s) indicates a void 

filled with soil or very soft soil zone, which is confirmed by the weight of hammer recording at 11 

m depth (37 ft) from the SPT. The SPT-seismic FWI effectively characterizes subsurface soil/rock 

stratigraphy and properties and anomalies at this site.  

 
Figure 4.28 Kanapaha site: comparison of Vs with SPT N-values 
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4.5 Correlation between SPT N-values and Vs 

 

To correlate Vs with SPT 𝑁60 values, it is necessary to interpolate 𝑁60 to match the Vs-

measurement depths. This is because SPT data are typically recorded at non-uniform depths, while 

Vs measurements are taken at uniform depths (e.g., 2 ft cells). Linear interpolation between the 

nearest SPT points is a straightforward and commonly used approach. For example, SPT-N value 

at depth 𝑧∗, where 𝑧low ≤ 𝑧∗ ≤ 𝑧high, is determined by a linear interpolation of 𝑁60 as: 

𝑁60(𝑧∗) = 𝑁60,low + [𝑁60,high − 𝑁60,low]
𝑧∗−𝑧low

𝑧high−𝑧low
,  (4-1) 

where 𝑧∗ is the target depth for interpolation (e.g., Vs measurement depth); 𝑧low and 𝑧high are 

bounding depths of the SPT data; 𝑁60,low and 𝑁60,high are 𝑁60 values at 𝑧low and 𝑧high, 

respectively. The Vs and interpolated SPT-N data for all 3 sites (Newberry, Bell, and Kanapaha) 

are shown in Fig. 4.29.   

 

Figure 4.29 SPT-N versus Vs values for all three sites 
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A popular approach is to assume  (Anbazhagan et al., 2012; Rahimi et al., 2020) 

𝑉𝑠 = 𝑎(𝑁60)𝑏. (4-2) 

Taking the natural logarithm (ln) of both sides transforms the equation into a linear form: 

ln (𝑉𝑠) = ln(𝑎) + 𝑏 ln(𝑁60). (4-3) 

Let 𝑥 = ln(𝑁60) and y = ln (𝑉𝑠), then the equation becomes: 

𝑦 = 𝛼 + 𝑏 𝑥, (4-4) 

where 𝛼 = ln(𝑎) and 𝑏 are determined through linear least-squares fitting. 

 
Figure 4.30 Least-squares fitting for finding correlation between SPT-N values and Vs 

 

Based on the least-squares fitting (Fig. 4.30), the linear relation is as: 

𝑦 = 4.7127 + 0.3226 𝑥    with 𝑅2 = 0.5599.  
(4-5) 
 

From equation 4-5, 𝛼 = 4.7127 and 𝑏 = 0.3226, giving 𝑎 = 𝑒𝛼 = 𝑒4.7127 = 111.35. Thus, the 

power-law relationship is: 

𝑉𝑠 = 111.35 × (𝑁60)0.324. (4-6) 

The coefficient of determination 𝑅2 for the model is 0.5599, indicating that approximately 56% of 

the variation in Vs is explained by the power-law relationship with 𝑁60. This correlation provides 
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a practical tool for estimating Vs values from SPT 𝑁60 or SPT 𝑁60 from Vs values, aiding in 

geotechnical analyses and site characterization. 

4.6 Conclusion  

Field experiments were conducted to verify the capabilities of the SPT-seismic method in 

imaging voids/anomalies and charactering soil/rock properties and layering. The method relies on 

3D FWI of SPT-induced wavefields with in-depth sources and surface receivers. The experiments 

were performed at 3 sites (Newberry, Bell, and Kanapaha) with two test areas at Newberry site, 

one area at Bell site, and one area at Kanapaha site. Each test area was 36 × 18 m (120 × 60 ft), 

with a 2D grid of 72 vertical geophones to record data induced by an SPT at the center of each 

area. Depths of SPT varied from 51 to 63 ft at sites.  

Seismic results suggest that the SPT-seismic method worked effectively at all three test 

sites. Soil/rock properties and voids can be characterized at sub-meter pixels over a large 3D 

domain of 24 × 36 × 18 m (80 × 120 × 60 ft in depth × length × width) or (e.g., up to 60 m away 

from SPT location and 20 ft beyond SPT depth). Multiple voids at various depths from 15 to 55 ft 

were detected with locations and dimensions consistent with SPT data. The inverted Vs profiles of 

soil and rock consistently aligned with SPT N-values at all three sites.  

Leveraging SPT-induced wavefields predominantly composed of body wave components 

within rock masses, the method introduces new imaging capabilities for subsurface soil/rock with 

enhanced accuracy and resolution at varying depths. It enables characterization at sub-meter pixels 

across a substantial 3D volume. Requiring only a single borehole for 3D imaging, it proved cost-

effective and efficient for site characterization, especially for imaging of deep voids within 

weathered and karst rock. 
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In addition, the method’s ability in charactering soil/rock around and beyond an SPT 

borehole is significantly important for design and construction of deep foundations. It allows us to 

use a single SPT at the center of a pile group to characterize the entire volume of materials 

supporting all piles in the group (around and below pile tip). It is particularly useful in weathered 

and karst rock, where both SPT and piles often end near the top of bedrock. For example, piles 

could socket within the stiff layer above the void due to refusal, leading to insufficient capacity. 

The ability to image soil/rock beyond the SPT depth can help to reduce the cost of invasive tests, 

as well as minimize the risk of pile failure/collapse due to unexpected site conditions.  
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Chapter 5 – IMPLEMENTATION OF 3D SPT- SEISMIC SOFTWARE 

(TASK 4) 

5.1 Introduction 

Task 4 entailed the development of a graphical user interface (GUI) software and an 

accompanying user manual for the 3D SPT-seismic waveform tomography (3D SPT-SWT). The 

primary focus was on creating software that supports graphical input, analysis, and output, 

specifically designed for technician-level personnel operating with basic training.  

The GUI allows users to input critical parameters such as the dimensions of the analysis 

domain, locations of receivers (geophones) and sources, as well as field-collected data. Users can 

perform data conditioning tasks—such as filtering and windowing—and have the capability to 

exclude poor channels (faulty receivers) or profiles (defective sources) from the dataset prior to 

inversion analysis. 

After data conditioning, the software executes the 3D SPT-seismic FWI algorithm 

developed in Task 1, producing 3D renderings of subsurface S-wave (Vs) and P-wave (Vp) 

velocities. These results are displayed within the GUI for user interpretation. Additionally, users 

can save input geometry and project data—including conditioned data, Vs and Vp values, 

waveforms, and least-squares error metrics—for future analysis or for transferring analysis files. 

Saved projects can be reopened in the GUI at any time. 

This report includes a comprehensive user manual for operating the software. A summary 

of the software development process is presented below. 
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5.2 Summary of software development and validation 

The primary objective of developing the GUI software is to enable users to upload data 

files, analyze the data, and obtain subsurface 3D renderings of S-wave (Vs) and P-wave (Vp) 

velocities without the need for programming knowledge. To achieve this, the GUI has been 

developed using MATLAB, the same programming environment utilized for the original code in 

Tasks 1-3. 

To ensure that the GUI functions identically to the original code and to verify its correct 

implementation without any loss of functionality or introduction of errors, each major 

computational component of the code has been rigorously validated. The validation process 

involved running field experimental data from three test sites, Newberry, Bell, and Kanapaha sites, 

through the GUI and comparing the results with those obtained from the original code in Task 3. 

In each case, the absolute differences between the GUI results and the original results were 

calculated, yielding zero or negligible discrepancies. This outcome confirms that the GUI 

implementation is accurate and that the software is robust across various site conditions. 

5.3 Conclusion 

A standalone Graphical User Interface (GUI) software for 3D SPT-Seismic Waveform 

Tomography (3D SPT-SWT) has been successfully developed. Written in MATLAB and compiled 

into an executable file, the software can be run on computers without the need for MATLAB 

installation. The required computational time is 4 to 24 hours for a setup involving 24 to 72 

geophones, with the total processing time depending on the recording durations and the number of 

geophones employed.  For a small test area of 40 x 60 ft on ground surface with 24 geophones, the 

software can provide results within 4 hours on a standard computer.  
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 The software encompasses several features that allow users to graphically input geometry, 

import data, pre-process data, generate an initial model using spectral analysis, and perform 

inversion to obtain the final outputs of 3D S-wave (Vs) and P-wave (Vp) velocities. For result 

assessment, the program provides waveform comparisons between observed and estimated data, 

as well as least-squares error calculations for each iteration. Furthermore, inversion results and 

input parameters can be saved and reloaded within the program, facilitating future analyses and 

the transfer of analysis files. A comprehensive user manual for the software is included in the 

Appendix. 
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Chapter 6 – SUMMARY 

6.1 General 

This project advanced the state-of-the-art in geotechnical site characterization by 

developing and optimizing a novel 3D SPT-seismic method for high-resolution subsurface 

imaging. Specifically, the method integrates seismic wavefields generated during Standard 

Penetration Test (SPT) hammer strikes with a 3D FWI framework to capture body wave energy at 

depth. The framework adopts a hybrid time-frequency domain approach, where forward wave 

simulations are conducted in the time domain and inversion is performed using selected dominant 

frequencies, significantly reducing computational memory (RAM) requirements. 

The 3D SPT-seismic method was first tested on synthetic datasets created from realistic 

soil and rock profiles with embedded voids, demonstrating its ability to accurately characterize 

subsurface anomalies and material properties at depth. It was then applied to field experimental 

data, successfully imaging voids, weak zones, and variations in soil and rock properties. The 

results showed that the method could achieve high-resolution 3D images extending 60 ft away 

from SPT boreholes. The seismic results correlate well with the SPT-N values, confirming the 

accuracy and reliability of the method. 

Additionally, this study explored the practical implementation of the SPT-seismic method, 

including automation of data collection, optimization of analysis workflows, and validation against 

field measurements. A standalone GUI software module for the 3D SPT-seismic FWI has been 

developed and transferred to FDOT for future applications. Further discussions on the individual 

components and findings of this study are presented in the following sections. 

 



 

92 

6.2 Development of 3D SPT-seismic FWI algorithm 

A novel 3D SPT-seismic FWI algorithm has been developed for advanced geotechnical 

site characterization. This algorithm integrates seismic waveform data recorded on the surface with 

FWI techniques to extract detailed 3D material properties, including S-wave (Vs) and P-wave (Vp) 

velocities, even at significant depths. The method is specifically designed to address challenges in 

resolving complex subsurface features in geotechnical investigations. 

The algorithm was tested on synthetic models simulating typical Florida geology, 

consisting of soil layers overlying variable limestone with embedded voids. Waveform data were 

generated using a 2D grid of surface sensors spaced 10 feet apart and in-depth sources placed at 

4-foot intervals along a vertical SPT line. These data were analyzed as if collected from actual 

field experiments. The algorithm successfully characterized material properties (Vs, Vp) in 3D 

within 60 ft from the SPT line and to depths of 100 ft. It accurately identified void locations, 

shapes, and layer interfaces, demonstrating its capability to resolve complex subsurface features. 

These results validate the algorithm’s potential for high-resolution subsurface imaging in 

geotechnical applications. 

6.3 Optimization of test configurations for 3D SPT-seismic FWI 

Optimization of test configurations (receiver locations and source intervals) has been 

performed for the 3D SPT-Seismic FWI algorithm. The objective was to determine the minimum 

number of receivers (maximum spacing) and sources (maximum interval) required for successful 

characterization of variable layers and embedded voids. Several configurations with receiver 

spacings from 7.5 ft to 22.5 ft and source intervals of 2 ft and 4 ft were tested on two synthetic 

models with variable soil or rock layers and embedded voids. The accuracy and resolution of 

inverted Vs and Vp profiles were compared to identify the optimal configuration. 
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From the results of the analysis, a receiver spacing of 10 ft and an SPT source interval of 

4 ft are recommended for field testing to ensure accurate characterization of both Vs and Vp 

profiles. If only the Vs profile is required, a receiver spacing of up to 15 ft can be used, although 

Vp accuracy may be reduced. Reducing the source interval to 2 ft did not improve the results due 

to data redundancy, confirming that intervals smaller than 4 ft are unnecessary. These optimal 

configurations are recommended for field experiments. Additionally, for field applications, 

recording all SPT blows within intervals of 2–4 ft is advised to enhance signal-to-noise ratio and 

ensure reliable data for accurate subsurface imaging. 

6.4 Verification of 3D SPT-seismic method at field test sites 

The developed 3D SPT-seismic method has been successfully applied to field experiments 

for imaging voids and characterizing soil and rock properties. Field tests were conducted at three 

sites: Newberry (two areas), Bell (one area), and Kanapaha (one area). Each test area measured 36 

× 18 m (120 × 60 ft) and utilized a 2D grid of 72 vertical geophones on the surface to record 

seismic wavefields induced by an SPT at the center, with SPT depths ranging from 51 to 63 ft. 

Based on the field experiments and results at the three sites, the 3D SPT-seismic method 

demonstrated several advantages. First, it accurately characterized soil/rock properties and 

detected multiple voids at depths of 15–55 ft with sub-meter resolution across a 3D domain of 24 

× 36 × 18 m (80 × 120 × 60 ft). Second, the inverted Vs profiles consistently aligned with SPT N-

values, confirming the accuracy of the method. Third, the use of SPT-induced wavefields, 

dominated by body waves, enabled high-resolution imaging at varying depths with minimal 

additional field equipment. 
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The method’s ability to characterize materials around and beyond the SPT borehole is 

particularly beneficial for the design and construction of deep foundations. It allows a single SPT 

at the center of a pile group to image the entire volume of materials supporting all piles, reducing 

the need for multiple invasive tests. Additionally, it minimizes risks of pile failure by detecting 

unexpected conditions, such as voids or insufficiently stiff layers beneath pile tips. The field results 

confirm that the 3D SPT-seismic method is an effective and cost-efficient tool for geotechnical 

site investigations, particularly for the design of deep foundations. 

6.5 Implementation of 3D SPT-seismic FWI software 

A standalone GUI-based software for the 3D SPT-seismic FWI analysis has been 

developed. The software is written in MATLAB and compiled into an executable file, allowing it 

to run on computers without requiring MATLAB. The processing time ranges from 4 to 24 hours 

per dataset, depending on the number of geophones and the depth of SPT testing. 

The software includes a user-friendly interface with several features to simplify data input 

and analysis. Users can graphically input parameters, such as the spacing and number of 

geophones, and import raw seismic waveform data directly from a hard drive. It also enables users 

to condition input data through filtering, windowing, and removing bad channels. A quality check 

feature allows users to review the conditioned data before proceeding with the analysis. 

The software outputs detailed subsurface profiles, including S-wave (Vs) and P-wave (Vp) 

velocities, which are displayed on the GUI and can be exported for reporting purposes. A 

comprehensive user manual, included in the Appendix, provides step-by-step guidance on using 

the software, ensuring accessibility for users with minimal training. The manual also includes 

examples of real seismic waveform datasets to aid in understanding the process and results. This 
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software streamlines the analysis workflow, making the 3D SPT-seismic FWI method practical 

for geotechnical practitioners. 
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Appendix: Software Manual 

1. Introduction 

Welcome to 3D SPT-Seismic Waveform Tomography (3D SPT-SWT) software program, 

designed for analyzing SPT-seismic data to extract detailed 3D subsurface P/S-wave velocity 

profiles. This versatile tool provides new capabilities for comprehensive site characterization of 

soil/rock and buried anomalies. The software boasts a range of features, including: 

• Modifiable parameters. 

• Easy data import. 

• Convenient pre-processing of measured data. 

• Inversion capabilities 

• Save and export results.  

The program's workflow includes six main components: geometry, import data, preprocessing, 

dispersion analysis, initial wave velocity models, and inverted results. Importantly, each 

component depends on the preceding one; for instance, parameters must be imported before 

generating or importing data. If you have any questions or need assistance with specific aspects of 

the program, email khiem.tran@essie.ufl.edu.    

2. Start Page 

Figure 1 shows the first page when you run the software. The main menu includes File, Settings, 

and View. 

  

 

Figure 1.  Start Page 

 

  

mailto:khiem.tran@essie.ufl.edu
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There are six required steps for the 3D SWT analysis including: 

1. Geometry 

2. Input Data 

3. Data Pre-processing 

4. Spectral Analysis  

5. Initial Model 

6. Inversion 

3. Input Parameters 

3.1 New Project 

To start a project, choose either:  

1. Settings > Geometry 

2. Click File > New. 

This action will open the “Geometry” page as seen in Figure 2. On this page, there are required 

parameters as defined in Table 1. 

 

Figure 2. Geometry Page 



 

101 

Enter values in editable boxes for the corresponding parameters. As an example, see Figure 3. 

Table 1. Geometry settings 

Medium 

X/Y/Z-Start - Starting location of grid array [m, ft]   

X/Y/Z-Finish - Ending location of grid array [m, ft] 

dx/dy/dz - Spacing of grid points in x/y/z direction [m, ft] 

Receiver Properties 

X/Y/Z -Start - Physical start location of receivers [m, ft] 

X/Y/Z -Finish - Physical end location of receivers [m, ft] 

dx/dy/dz - Spacing between receivers [m, ft] 

Source location 

X - Physical x coordinate location of shots [m, ft] 

Y - Physical y coordinate location of shots [m, ft] 

Z Range - Excel cell range to import source depths  

Select - Import source depth location (Excel files only) 

Add  

SPT Source 
- Add a new SPT Source file 

Material properties 

Nu - Poisson ratio of material 

Vs Max - Maximum shear wave velocity of material [m/s] 

Vs Min - Minimum shear wave velocity of material [m/s] 

Density - Density of the medium [kg/m3, lb/ft3] 

Time Properties 

t0 - Delay Time [s] 

dt - Sampling rate (time interval) [s] 

Unit 

SI - m 

English - ft 

 

After entering required parameters, click “Import” button as shown in Figure 4. If parameters are 

properly imported, there will be a sketch of the analyzed domain displayed in the “Step 1” tab with 

a message “Parameters parsed successfully”. Otherwise, fix any errors in the parameters. 
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Figure 3. Geometry Parameters 

 

Figure 4. Import Geometry Parameters 
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3.2 Open: Geometry or Project 

The second way to import geometry is by opening an existing parameter file. To do this, navigate 

to File > Open > Geometry. If you prefer to open a project containing processed data and 

inversion results, select File > Open > Project.  

 
Figure 5. Open Parameters 

Depending on your choice, the corresponding screen for opening geometry (Figure 6) or a project 

(Figure 7) will appear, as shown below.  

 
Figure 6. Open Geometry file(*.xlsx) 
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Figure 7. Open Project file (*.mat) 

Navigate to the parameter file to open it. This will bring the program back to the same 

page. The status bar in the bottom right of the screen will say “Parameters Opened” if the parameter 

file was successfully imported. If needed, modify existing values and reimport them by clicking 

the “Import” button.  

4. Data 

To ensure accurate results, field data must be carefully imported and, if necessary, pre-

processed (Section 5). The program provides a suite of functions to manage this process, including 

importing, generating, viewing, modifying, and saving the project. 

4.1 Open Data 

To import data to enter the “Step 2” tab (Figure 8), choose either:  

1. Settings > Input Data 

2. Click the “Next” button in the “Step 1” tab. 

3. Click the “Step 2” button in the “Step 1” tab. 
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Figure 8. Input Data 

To initiate the process, click the 'Open' button located in the upper left corner. This action 

prompts 'Select File to Open' window (Fig. 9). Select multiple files by clicking the desired files. 

Please note that the number of data files corresponds to the sources added in Step 1 during the 

Excel data import and the files must be named in the numerical order according to their location. 

 

Figure 9. Open data files 
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Then click "Open" to load the selected data files. The software will display the loaded data 

as shown in Figure 10. When the data is successfully imported, a green status indicator will confirm 

this. You can use a slider to specify the duration time. With the green status, you're now ready to 

move on to the next phase of your analysis or configuration. 

After importing the data, click "Time Domain" or "Frequency Domain" to view the data in 

the respective domain if needed. Use the "File Number" spinner to navigate through each shot's 

data. 

 

 

Figure 10. View data 

4.2 Viewing Imported Data 

To view the data that has been imported/opened into the program, select View > View Imported 

Data. This will produce a window to view the data (Figure 10), which can be seen in time and 

frequency domains.  

5. Data Pre-processing 
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Step 3 of the 3D SWT analysis is to pre-process the imported data. This needs to be done 

carefully. Choose either of the below options to open the window as seen in Figure 11.  

1. Settings > Preprocessing. 

2. Click the “Next” button in the “Step 2” tab. 

3. Click the “Step 3” button in the “Step 2” tab. 

 
Figure 11. Data Pre-processing page 

The following values are required: 

•  Set the maximum time (Time_max) duration (in seconds) for the input data, making sure 

it aligns with your collected data's time range.  

• Filtering frequencies: f1, f2, f3, and f4 (Hz) as shown in Figure 12. Configure the filtering 

frequencies as in Figure 11, adjusting these four values to suit your data processing and inversion 

requirements. 
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Figure 12. Filtering bandwidth 

Take the following steps: 

1. Enter values for all the inputs: Time_max and filters (f1, f2, f3, and f4). 

2. Select “Filter” to filter the data (Figure 15). 

3. As seismic cables are often looped in field experiments, it is required to rearrange channel 

locations. For instance, for a data set with 72 channels. The correct geophone array is always as 

below:  

 

Figure 13. Correct geophone order 

However, due to cable looping, the arrangement of geophones in the field can be as Figure 14. 

Click “Compile Geophone Array” to enter the field geophone array into the edit box (specify the 
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first and last geophone on each line, see Figure 14), then click "Rearrange" to automatically 

reorder channels correctly (as shown in Figure 13). 

 

Figure 14. Geophone array in the field 

4. Select “Kill Source” to kill poor profiles (Figure 16). Click “Kill Source” again to “Unkill 

Source”. 

5. Select “Average Source” to average profiles in the same source depth (Figure 17).  

6. Select “Kill Trace” to kill the poor channels (Figure 18). Click “Kill Trace” again to 

“Unkill” the trace. 

7. Click on “Gain Balance” button to show a gain balance profile (Figure 19). 

8. Click on “Spectrum” button to check the frequency spectrum (Figure 20). 

9. Select “Restore plot” to show the raw data before pre-processing.  

10. Show original data table, which will give you the shot #, source depth, and source node # 

of original datasets.  

11. Show processed data table, which will give you the shot #, source depth, source node # and 

average number of source for each node of processed datasets. 
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Figure 15. Filtering data Figure 16. Kill source 

 

  

  

Figure 17. Average source Figure 18. Kill trace (blue channels are removed)  
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Figure 19. Gain Balance 

 
 

Figure 20. Check the Spectrum 

 

6. Spectral Analysis 

Step 4 of the 3D SWT analysis is to do spectral analysis. It is optional and can be skipped if the 

initial model is already known (e.g., reprocessing). This step is to determine the range of S-wave 

velocity used in the initial model. To do this, choose either: 

1. Settings > Spec Analysis. 

2. Click the “Next” button in the “Step 3” tab.   

3. Click the “Step 4” button in the “Step 3” tab. 

This action will bring up a tab as shown in Figure 21. 

To do this analysis, follow the steps below: 

1) Click “Open Surface Data”, which triggers a "Select File to Open" window. 

2) Select Channels: Enter values for Channels start and Channels end, and then click 

“Select” button. For example, select the first 12 channels (see Figure 22). Only one line 

of geophones is used for this analysis.  

3) Click “Up sampling” button to up sample the raw data if necessary. For example, up-

sampling twice, the 12 traces will become 48 traces (Figure 23). 



 

112 

4) Data is sometimes backwards with respect to receiver numbers (Figure 24), due to cable 

looping in the field. To fix it, simply click the “Flip” button (Figure 24), to make sure 

travel time increases with channel numbers as shown in Figure 22.  

5) Enter values for “Velocity max” and “Frequency max” parameters (for analyzing and 

plotting), where “Velocity max” and “Frequency max” are the maximum velocity and 

frequency, respectively. For example, we set “Velocity max” as 1000m/s, and 

“Frequency max” as 30 Hz. 

6) Click “Analyze” to generate the dispersion curve and the status bar changes to 

“Running Spectral Analysis”. The status lamp will display yellow, and the gauge will 

show the calculation progress (see Figure 26). 

After completing the Spectral Analysis, use the results to generate a reasonable initial model (refer 

to the next section). 

 

Figure 21. Dispersion image. 
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Figure 22. Select channels 

 

 
Figure 23. Up sampling 
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Figure 24. Flip data 

 
Figure 25. Calculated dispersion image 
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7. Initial model 

Step 5 of the 3D SWT analysis is to generate the initial model. To do this, choose either: 

1. Settings > Initial Model 

2. Click the “Next” button in the “Step 4” tab.   

3. Click the “Step 5” button in the “Step 4” tab. 

 Then: 

a) Input S-wave velocity at the surface (Vs top) and the bottom (Vs btm). Vs at the bottom 

must be larger or equal Vs top.  

b) Click “Generate” button to generate the initial model (Figure 26).  

 

Figure 26. Initial model for S- and P-wave velocities. 

  



 

116 

8. Inversion 

The final step (Step 6) of the 3D SWT analysis is to invert data for Vs and Vp profiles. The inversion 

process combines all previous aspects of the user interface including the parameters, imported 

data, and initial model. Vs and Vp models are updated iteratively by matching the synthetic data 

with the field data, and the final Vs and Vp models are created when the inversion is complete. 

Also, the estimated source, Errors, and Waveform comparisons are plotted for each iteration. 

To do this, choose either: 

1. Settings > Inversion 

2. Click the “Next” button in the “Step 5” tab.   

3. Click the “Step 6” button in the “Step 5” tab. 

Which will navigate to the inversion page (Figure 27). 

 

Figure 27. Inversion page 

As shown in Figure 27, do the following: 

1) In the “Iterations” box: Enter the maximum number of iterations (Iter max)  

2) Enter the number of cores, ensuring it does not exceed your computer's core count. 
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3) In the “Filter” box: Enter 3 values: Frequency Start, Frequency Interval, and Frequency 

Finish. Shown in the example (Figure 28), the filtering frequencies are 15 to 35 Hz with 2 

Hz frequency intervals. It is wort noting that we simulate the forward modeling waveform 

in time domain but implement the inversion in the frequency domain to save RAM. These 

specified frequencies will be used for inversion. 

4) Enter near-field distance (R_nf) to account for material damping if needed. Default value 

is 0. 

5) Enter the center frequency of filtered data fc. Or click the Auto button, which will set the 

center frequency automatically according to the mean center frequency of filtered data. 

6) To do the inversion analysis, click “Run” button.   

7) To stop the inversion analysis, click “Stop” button. 

Inverted Vs, Vp, waveform comparison, and error value for each iteration will be displayed during 

inversion and at the end (Figure 28-31). Throughout the inversion process, the software will 

provide insights such as inverted Vs and Vp values, waveform comparisons, estimated source, and 

error values for each iteration. You can monitor these results to assess the inversion's progress and 

quality.  

The “Vs Max” box displays the maximum value of the inverted shear wave velocity (Vs_max), 

while the “Vs Min” box shows its minimum value (Vs_min). Similarly, the “Vp Max” box 

indicates the maximum value of the inverted compressional wave velocity (Vp_max), and the “Vp 

Min” box reflects its minimum value (Vp_min). 

After completing the inversion, you can adjust the 3D rendering to highlight low and high velocity 

zones. 

1) By editing the “Vs Low” box, you can make the low-velocity zone (less than Vs_Low) 

visible. Similarly, by editing the “Vs High” box, you can enhance visibility of the high-

velocity zone (more than Vs High). 

2) For P-wave velocity, editing the “Vp Low” box shows the low-velocity zone (less than 

Vp_Low), while editing the “Vp High” box shows the high-velocity zone (more than 

Vp_High). 
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This customization allows for clearer visualization of specific velocity zones in your 3D model. 

 

Figure 28. Inverted Vs 

 

Figure 29. Inverted Vp 
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Figure 30. Waveform comparison 

 

Figure 31. Error 

9. Save and Export 

9.1  Save: Geometry or Project 

To create a parameter file that can later be imported, select File>Save>Geometry/Project.  
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Figure 32. Save parameters 

The following dialogue box allows for selection of a location and file name for the parameters. 

 
Figure 33. Save Geometry file (*.xlsx). 
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Figure 34. Save Project file (*.mat). 

If a Geometry/Project file location and name are already selected, the save function will overwrite 

it with the current parameters. Select the desired location and name and click “Save”. Once saved, 

the files can be reimported using the open option (Section 3.2). 

9.2 Save as: Geometry or Project 

The option to save the parameters to a new file location is available by selecting File>Save 

As>Geometry/Project. 

 

Figure 35. Save As 
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The below dialogue box allows for selection of a location and file name for the parameters. 

 

Figure 36. Save as Geometry file (*.xlsx). 

 

Figure 37. Save as Project file (*.mat). 

Select the desired location and name and click “Save”. Once saved, the file can be reimported 

using the open option (Section 3.2). 
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9.3 Export 

To export inversion results, navigate to File > Export > Inverted Vs/Inverted Vp/Waveform 

Comparison/Error (Figure 38). This allows you to generate an image file of the current display. 

Alternatively, you can export the Inverted Vs, Inverted Vp, or Error data in *.xlsx format. Simply 

click the desired option, then choose the file location, name, and type to complete the export 

process. 

 

Figure 38. Export image file. 

 

 


